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EXERCISE 1 – TUTORIAL

Introduct ion to ESA Earth Observat ion and evolut ion 

– ESA EO data on the web

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 acquire skills in retrieving satellite imagery from both ESA and 
third-party missions

 conduct specific analyses utilizing the EO Browser

 install ESA SNAP and execute fundamental image operations

 explore the spectral curve of various surface types

1 | Exercise outline
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The European Space Agency (ESA) has several key mission programs

covering various areas of space exploration, Earth observation, scientific

research, and international collaboration. Some of the main mission

programs include:

• Earth Observation (EO) Programs: ESA has a comprehensive portfolio of

EO missions aimed at monitoring and understanding various aspects of

the Earth's environment. Examples include the Copernicus program,

which has developed Sentinel missions to manage the environment,

understand and tackle the effects of climate change, and safeguard

everyday lives, Earth Explorers designed to improve our understanding

of Earth, and the Living Planet Program.

• ESA provides EO mission data addressing almost all parameters

retrievable by EO satellites

2 | Background
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• Exploration Programs: ESA conducts various scientific missions to

explore the cosmos and increase our understanding of the universe.

This includes missions like the Hubble Space Telescope, the Gaia mission

for astrometry, and the Planck mission for studying the cosmic

microwave background. ESA is actively involved in space exploration

initiatives, including the ExoMars program in collaboration with

Roscosmos, which aims to search for signs of past or present life on

Mars. Additionally, ESA contributes to lunar exploration efforts, robotic

missions, international collaborations with agencies like NASA, human

spaceflight missions in collaboration with the International Space

Station (ISS). The agency contributes astronauts, research, and

technology to advance human space exploration.

• Telecommunications and Integrated Applications: ESA focuses on

developing advanced satellite communication technologies and

applications. This includes programs such as the Advanced Research in

Telecommunications Systems (ARTES) program.

• Navigation Programs: ESA is involved in satellite navigation programs,

such as the Galileo program, which aims to provide Europe with its

global navigation satellite system (GNSS).

It's important to note that the specifics of ESA's mission programs may

evolve over time, and new programs may be initiated. Within this course,

we will focus mainly on the field of EO Programs.
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3 | EO Mission Programmes

https://earth.esa.int/eogateway

ESA's EO Mission Programme is dedicated to several ongoing and past

Earth Observation satellite missions. Users can learn all about ESA's

dedicated Earth Explorers, Copernicus Sentinels, Heritage Missions or

collaborations with other agencies through the Third Party Missions

programme by accessing the dedicated Earth Online website that

presents news and information on ESA activities in the field of Earth

observation. The website offers information about ESA’s Earth

Observation data, along with insights into the satellite missions and

instruments that acquire this data.
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3.1 Earth Explorers

The Earth Explorers program comprises a set of satellites united in their

mission to enhance Earth science by addressing fundamental scientific

inquiries through the observation of crucial Earth systems.

Each Earth Explorer is specifically designed to monitor distinct facets of

the Earth's system, including the Cryosphere, Hydrosphere, Atmosphere,

Ionosphere, and the Earth's interior. The primary aim of these missions is

to gain insight into the Earth as a geosphere and comprehend the

intricate interactions among spheres and sub-spheres

Current Earth Explorer missions include Aeolus, CryoSat, SMOS, and

Swarm. Future expansions will introduce new missions like EarthCARE,

Biomass, and FLEX.
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Users have the ability to engage with three-dimensional representations

of ESA satellites and payloads via the link: https://visuals.earth.esa.int/

Additionally, users can explore case studies that showcase practical

applications of the satellite data.
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Information about the mission and its instruments

3D model of ESA 
SMOS satellite

See data application

Interactive
visualisation

Further visualisation and analysis options, information on data access      

https://visuals.earth.esa.int/


VisioTerrra

VisioTerra is a French company that focuses on scientific consulting in the

field of Earth observation as an independent entity. It enables access to

online visualisation of GOCE altimetry and SWARM products.
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3.2 Sentinel Online - Copernicus Sentinels

https://sentinels.copernicus.eu/web/sentinel

https://sentinel.esa.int/web/sentinel/home

Copernicus stands as the most ambitious Earth observation program to

date, aiming to deliver precise, timely, and readily available information

to enhance environmental management, comprehend and alleviate the

impacts of climate change, and ensure civil security.

ESA developed the Sentinel satellite family to meet Copernicus program

needs. The Copernicus Ground Segment oversees operations, data

acquisition, and distribution. Currently, three two-satellite constellations

orbit, with two individual satellites, including Sentinel-5P. After Sentinel-

1B, Sentinel-1C will restore the Sentinel-1 constellation.

Sentinels offer diverse observations, from Sentinel-1's all-weather radar

images (2014, 2016) to Sentinel-2A's high-res optical images (2015).

Sentinel-3 satellites (2016, 2018) provide ocean and land data, with

Sentinel-3 marine operated by EUMETSAT and Sentinel-3 land by ESA.

Sentinel-5P, launched on October 13, 2017, is the first Copernicus

mission dedicated to atmospheric monitoring, reducing data gaps.

Sentinel Online aims to offer extensive information to prospective users

regarding the Sentinel program, including its specific missions,

operational priorities, and the Copernicus Thematic domains it caters to.

The technical platform prioritizes in-depth explanations covering

instruments, performance of data products, scientific applications,

Ground Segment processing, and guidance on how to access Sentinel

data.
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Users can explore Copernicus Sentinel missions and instruments through

SentiWiki, applications through Sentinel Success Stories, get an

immediate access to a wide range of open and free EO data and services

through Copernicus Data Space Ecosystem, check News, real-time info

about Sentinels missions through SentiBoard, Sentinel-2 Reprocessing

Status or explore Dunia – data platform for Africa.

9



10

3.3 Heritage missions

https://earth.esa.int/eogateway/missions/heritage-missions

ESA's Heritage Space Programme is dedicated to safeguarding, ensuring

accessibility to, and managing over four decades of Earth Observation

heritage data. This extensive dataset originates from more than 45

satellite missions that are no longer in operation, as well as from

dedicated Earth Observation campaigns conducted by ESA.

Included in the program are significant missions such as the European

Remote Sensing satellites (ERS-1 and ERS-2), Envisat, and the Gravity

Field and Ocean Circulation Explorer (GOCE).

The user can discover the instruments used in each of these featured

missions, access mission data and explore A number of tools that are

available for visualising, processing and analyzing.



4 | EO Training and Education

ESA is involved in a diverse array of initiatives related to education,

training, and capacity building in the field of Earth Observation (EO).

These efforts span from advanced training in state-of-the-art processing

techniques for the upcoming generation of scientists to broader outreach

activities and EO education for schools.

4.1 Earth Observation for Society (EO4Society)

https://eo4society.esa.int/training-education/

EO4Society is a program that focuses on utilizing Earth observation data

to address societal challenges. The EO4Society program aims to promote

the use of Earth observation data for various societal benefits, including

environmental monitoring, climate change studies, disaster management,

agriculture, and urban planning, among others.

Within this platform ESA has developed Massive Open Online Courses

(MOOCs) on various topics related to space exploration, science, and

technology. These courses are inclusive, accommodating individuals from

diverse backgrounds, such as scientists, policy-makers, educators,

professionals, students at schools or universities, and casual learners.

Each course lasts several weeks, challenging the traditional educational

framework by integrating data, video content, applications, and online

materials.
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The educational journey can be tailored to individual preferences due to

its social dimension, which includes online discussions and feedback from

educators, along with the incorporation of optional materials. Each MOOC

training course has its dedicated page with learning materials.

Link: https://eo4society.esa.int/training-education/massive-open-online-

courses-moocs/

Thematic Exploitation Platforms (TEPs)

Another result of EO4SocietyTEPs are collaborative and virtual

workspaces that grant access to Earth Observation (EO) data, along with

the necessary tools, processors, and information and communication

technology resources essential for effectively working with them. These

resources are made accessible through a unified and cohesive interface.

TEPs are adressing following topics: Coastal, Forestry, Hydrology,

Geohazards, Polar, Urban themes, Food Security

12

https://eo4society.esa.int/training-education/massive-open-online-courses-moocs/


4.1.1 Imperative MOOCs

https://www.imperativemoocs.com/

Imperative MOOCs is the platform for MOOCs and online learning

projects produced by Imperative Space whose one of the clients is also

ESA. Its Earth Observation courses have created innovative new

approaches to training and knowledge exchange in this field, and are

supported by purpose-built data apps-

4.1.2 Thematic Exploitation Platforms (TEPs)

Another result of EO4SocietyTEPs are collaborative and virtual

workspaces that grant access to Earth Observation (EO) data, along with

the necessary tools, processors, and information and communication

technology resources essential for effectively working with them. These

resources are made accessible through a unified and cohesive interface.

TEPs are adressing following topics: Coastal, Forestry, Hydrology,

Geohazards, Polar, Urban themes, Food Security.
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E.g. the Geohazards TEP (G-TEP) platform is built on the virtualization

and federation of satellite EO data and methods. Its primary goal is to

offer innovative solutions to the geohazards community's needs. By

utilizing advanced services for both Optical and Synthetic Aperture Radar

(SAR) data, it provides on-demand and systematic processing services

tailored to the specific requirements of user communities. The platform

seamlessly connects to extensive Copernicus Sentinels-1/2/3

repositories, High-Resolution Optical imagery, and over 70 terabytes of

EO data from archives like ERS and ENVISAT. Additionally, it interfaces

with specific data collections from missions such as JAXA’s ALOS-2, ASI’s

Cosmo-Skymed, and DLR’s TerraSAR-X, all made available through

special arrangements within the framework of the CEOS WG Disaster and

GSNL. This integration allows the platform to efficiently address the

challenges of monitoring tectonic areas globally by tapping into

significant compute power on multi-tenant Cloud Computing resources.
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4.1.3 Copernicus RUS Training Materials

https://eo4society.esa.int/resources/copernicus-rus-training-materials/

Operating from 2017 until December 2021, the Copernicus Research and

User Support (RUS) service sought to create an open-access online

platform with the goal of fostering the utilization of Copernicus data and

facilitating the expansion of educational and research and development

(R&D) initiatives. The primary objective of the RUS Service was to

encourage the utilization of Copernicus data and facilitate the expansion

of research and development (R&D) endeavors, including the

advancement of pre-commercial processing chains. This service is

structured within a scalable cloud environment, allowing for the remote

storage and processing of Earth Observation (EO) data.

Additionally, the RUS Service extended its support through on-site

training sessions, webinars, and online resources. Notably, this service is

accessible to a diverse user community and various types of institutions

at no charge.

Nowadays, the training sessions of the Copernicus RUS service are

available at EO4Society website.

15



4.2 ESA Learning Hub

https://learninghub.esa.int/

The ESA Learning Hub, managed by the SME section in ESA's Directorate

of Commercialisation, Industry, and Procurement, is an online platform

providing industry stakeholders and delegations access to training

courses and materials associated with ESA programs. As a central

repository aligned with ESA activities, it aims to enhance European

industry growth by supplementing core knowledge, competencies, and

overall competitiveness.

4.3 EO College

https://eo-college.org/

The EO College serves as a central hub for digital learning content

focused on Earth observation, remote sensing, and related subjects. This

platform is specifically designed to function as a repository for open

educational resources and online courses. In essence, it acts as a

comprehensive source for individuals seeking to enhance their knowledge

and skills in the field of EO through digital learning materials.
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4.4 SEOM (Scientific Exploitation of Operational Missions)

https://seom.esa.int/

The primary goal of the SEOM component within the Earth Observation

Envelope Program 4 is to unite, assist, and extend the extensive

international research community established through the ERS, ENVISAT,

and Envelope programs over the past two decades. Its objective is to

enhance the global leadership of the European Earth Observation

research community by facilitating comprehensive utilization of

observations from upcoming European operational EO missions. SEOM

aims to empower the scientific community to explore numerous new

avenues of research made possible by the free and open access to data

from operational EO missions.

17



5 | Future of EO - ESA Φ-lab

The primary objective of ESA's Φ-lab initiative is to accelerate the future

of Earth Observation (EO) by fostering transformative innovations. These

innovations have the potential to revolutionize or establish entire

industries through novel technologies, ultimately enhancing the global

competitiveness of the European EO industrial and research sectors.
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6 | Video lectures and tutorials, Sentinel App

SNAP Toolbox

There are various tutorials and guides available on YouTube that cover

the use of the SNAP (Sentinel Application Platform) toolbox, such as

SNAP Toolbox. SNAP is developed by the European Space Agency (ESA)

and is used for the analysis and processing of remote sensing data,

particularly data from the Sentinel missions.

Sentinel App

The Sentinel App serves as a portal for gaining insights into the

Copernicus Sentinel satellites. It enables users to monitor the satellites in

real-time, access information on their essential features, stay updated

with the latest news, and delve into details about their offerings. Among

its features, users can explore intricate 3D representations of the

satellites, observe the past and upcoming instances when the satellites

will be visible from their location, etc.

For more information, see the lecture: 1. Introduction to ESA Earth

Observation and evolution – current and next generation missions
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EXERCISE 2 – TUTORIAL

ESA EO Data Access and Select ion, 

applicat ions of Copernicus Earth Observat ion data

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 acquire skills in retrieving satellite imagery from both ESA and 
third-party missions

 conduct specific analyses utilizing the EO Browser

 install ESA SNAP and execute fundamental image operations

 explore the spectral curve of various surface types

1

1 | Exercise outline



2 | Background

Most of the ESA's Earth observation datasets are easily accessible online,

free of charge. Users can acquire access by completing a simple

registration process.

The Copernicus Data Space Ecosystem provides full, free and open

access to large amount of Earth observation data, along with scalable

interfaces integrated with the Copernicus Sentinel satellites. This includes a

range of both new and historical Sentinel images, commercial datasets, as well

as Copernicus Contributing Missions.

Sentinel data is also accessible through Copernicus Data and Information

Access Services (DIAS), which are platforms designed to facilitate the

discovery, retrieval, and use of Copernicus satellite data, including data from

the Sentinel missions. There are several DIAS platforms available, each

offering a user-friendly interface and tools for working with the data.

The ESA Hub allows checking searches online by browsing and viewing

product metadata and measurements without downloading them.

Sentinel products are provided for download over HTTP in *.ZIP archive file

format.

Sentinel Hub is a cloud-based platform that provides access to satellite

data, particularly from the ESA Sentinel missions. The platform offers a

variety of services and tools for the retrieval, processing, and analysis of

satellite imagery. It is commonly used by researchers, developers, and

businesses to access Earth observation data for various applications,

including environmental monitoring, agriculture, urban planning, and more.

EO Browser is an online platform developed by Sentinel Hub that allows

users to visualize and explore satellite imagery, particularly from the

Copernicus Sentinel missions. Sentinel Hub provides the backend

infrastructure and access to the satellite data, while EO Browser serves as

the user interface for interacting with that data.

ESA not only provides satellite data from its own Earth Observation (EO)

satellite resources, but also facilitates access to Third Party Missions

(TPMs), which are non-ESA EO missions. Integrating data from these

diverse sources is crucial for enhancing the sustainability of satellite

services, expanding the scope of monitored parameters, and promoting

scientific development. Researchers and students alike can request third-

party data, but it's important to be aware of licensing conditions,

especially for users in certain countries, where national legislation on data

access may apply.
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3 | How to access ESA data

To access data from the European Space Agency (ESA), user can use

various platforms and tools provided by ESA. Here are some key sources:

Earth Online Portal

The Earth Online Portal serves as a gateway to a diverse range of Earth

observation resources. It includes a directory for discovering missions and

datasets, offering convenient access to satellite data, operational updates,

events, and tools to enhance data utilization.

Sentinel Online

The Sentinel online platform offers technical details about the Copernicus

Sentinel missions and allows systematic access to processed data, which is

readily accessible on the website. User registration is required for access.

Copernicus Contributing Missions Online

To obtain data with higher resolution, users can visit the Copernicus

Contributing Missions website. This platform offers comprehensive

information on all Contributing Missions that provide data complementing

the Copernicus Sentinels, addressing the requirements of the Copernicus

Services. Eligible users can access the data for free upon registration and

confirmation of their user category.
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• Since 24 January 2023 a new Copernicus Data Space Ecosystem has been

launched to provide free and open access to Earth Observation data from

all Sentinel satellites with new features for visualisation and data

processing.

• The previous Copernicus Data Hub distribution service that has been

providing access to Copernicus data is offering access to Sentinel data with

a gradual ramp-down of the operations capacity and data offering.

• Sentinel Data are also available via the Copernicus Data and

Information Access Services (DIAS) through several platforms.

4 | Copernicus Data Space Ecosystem

https://dataspace.copernicus.eu/
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The Copernicus Data Space Ecosytem allows us to access a wide range of

Earth observation data from the Copernicus Sentinel missions and more.

The Copernicus Data Space Ecosytem provides tools for easy discovery,

visualization and download which will be continuously upgraded.
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4.1. Registration and login

• We can register a new user or log in as an existing user to the portal.

• The Copernicus Data Space Ecosytem allows us to browse and visualize

satellite images freely, but we need to register and create an account to

be able to download them.
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After registration and login, it is possible to visualize or search EO data
products within portal. We can choose various satellite platforms, product
types, polarizations, and sensing modes for individual satellites:

Visualize or Search
options

Search by 
Product ID

Select data
source and set 
advanced filters

(see slide x)

Search area of interest

Search by date of image 
sensing or filter by months

Select Map background

Select area of interest

Advanced options
for analysis and 

visualization

Search by Date, 
select % of the

cloud cover

Choose Sentinel 
mission and data

product

Visualize data as 
color composition
or spectral index

Or create your own
color composition
or spectral index
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Levels of product types

- unprocessed raw data

- (Single Look Complex) contains complex images with amplitude and

phase in the slant range by azimuth imaging plane, in the image

plane of satellite data acquisition

- (Ground Range Detected) consists of focused SAR data that has been

detected, multi- looked and projected to ground range using an Earth

ellipsoid model

- (Ocean) provide geo-located geophysical products derived from

Level-1 for wind, wave and currents applications

The available Sentinel-1 data includes products

from the Sentinel-1 satellite constellation, including

Sentinel-1A (operational since 2014) and Sentinel-

1B (operational from 2016 to 2022)

Determines wheter the data was recorded during a

descending orbit (flight direction: north-south) or

an ascending orbit (flight direction: south-north)

The Relative Orbit Number is the number of full

orbits since the relative orbit 1 to the end of a cycle

Sentinel-1 operates in 4 instrument acquisition

modes: Stripmap (SM), Interferometric Wide Swath

(IW), Extra-Wide Swath (EW), Wave (WV)

Depending on the acquisition mode, different

swaths and identifiers are possible

Determines with which polarisation the data was

acquired. The first letter indicates the polarisation

when sending the signal, the second letter when

receiving the signal. Data can be acquired in single

polarisation HH or VV or in dual polarisation HHHV

or VVVH depending on the instrument mode

E.g. Sentinel-1 C-SAR - SAR Instrument that provides an all-weather, day
and night imagery at C-band at high and medium resolutions for land,
coastal zones and ice observations.
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4.2.Search results

After defining the search criteria, we get the results that can be further 

viewed, analysed or downloaded.

Image preview
(if available)

Main product 
information

Metadata
information

Image 
download
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EO Browser, developed by Sentinel Hub, is an online platform that

empowers users to explore and visualize satellite imagery from Earth

observation (EO) missions, with a focus on the Copernicus program.

Offering an intuitive and user-friendly interface, the platform is widely

utilized for educational, research, and environmental monitoring

purposes. Key features encompass direct access to Copernicus Sentinel

data, enabling users to visualize and analyze imagery within the browser.

Customization options allow users to tailor their view by adjusting

parameters like date and cloud cover, catering to specific research needs.

The platform's educational utility is evident in its use in educational

settings, introducing students to Earth observation and remote sensing

through its accessible interface. Additionally, EO Browser facilitates time-

lapse creation for monitoring changes in the Earth's surface over time.

EO Browser is a valuable tool for those interested in exploring and

understanding satellite imagery for a wide range of applications,

including environmental monitoring, agriculture, forestry, and urban

planning.

5 | Sentinel Hub - EO Browser

https://apps.sentinel-hub.com/eo-browser/

Registration or Log in
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Data source
selection

Selection of time
range of data
acquisition

Search the area
of interest

Log in

Area of interest

Marking the point of interest

Area measurement

Image download

Creating 3D view

Creating histogram view

Creating video sequences

After the search,the selected image can be visualised in the browser.

Images that meet
the search criteria

Visualization of the
selected image
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5.1.Optical data

In the visualisation tab, we can change the view mode (available are 

visualization options in the form of color compositions and spectral indices).

True color composition (R-G-B)

Normalised difference vegetation index (NDVI)
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Other visualization options

Available color compositions:

• True colour (bands: Red-Green-Blue)

• False colour (bands: NIR-Red-Green)

• Highlight Optimized Natural Color

• False colour (urban) (bands: 12-11-4)

• SWIR (bands: 12-8A-4)

Available spectral indices:

• NDVI - for vegetation monitoring

• NDWI - for water monitoring

• NDSI - for snow monitoring  

• Moisture index - for moisture monitoring

Available classifications:

• Scene classification map - classification

display based on ESA algorithms

+ Available custom visualization

We can also use a visualisation for custom color combinations or spectral

indices of default bands or the scripting tool and use additional datasets.
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An important visualisation tool of EO Browser is the Timelapse function.

We can choose multiple images filtered by date or month and select one

image per orbit, day, week, month or year. We can set prefered tile coverage

and % of cloud cover. Then we can select all or only some images and

play, download or share the timelapse visualisation.

Select/deselect image
Play a video, select transition mode, 

download or share your created timelapseSelect time range

The resulting timelapse of images from the Landsat 7 satellite showing the 
disappearance of the Aral Sea by 2020
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5.2.Radar data

When displaying radar data, we have the option to choose from 

various types of visualizations.

In accordance with specific requirements, the terrain can be displayed

using different polarizations, cross- polarizations, and corrections.
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6 | Sentinel Application Platform (SNAP)

https://step.esa.int/main/download/snap-download/

ESA Sentinel Application Platform (SNAP) is a software toolkit developed

by the European Space Agency (ESA) for processing and analyzing Earth

observation data, particularly data from the Sentinel satellites. SNAP is

part of the Sentinel Toolbox and is freely available to the public. It

provides a user-friendly interface and a comprehensive set of tools also

for working with a variety of other remote sensing data.

SNAP is widely used in the scientific community and by remote sensing

professionals for a variety of applications, including land cover mapping,

environmental monitoring, and disaster response. It is an open-source tool,

and its modular architecture allows for the integration of plugins and

additional functionalities.
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After installing and starting the software, we can open an image using 
File – Open Image or by Import option:
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Open image as RGB color composition

Display image in Natural Colors

(as seen by human eye)

Open image in False Colors or open as 

an Atmpospheric penetration image
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Upon opening an image, users can explore the image data through

the Product Explorer window. This encompasses opening RGB

composite images, navigating metadata, inspecting spectral bands,

and reviewing image masks. In the case of radar images,

amplitude or intensity can be visualized in various polarizations.

In the bottom-left Window Group, we can see 4 tools:

• Navigation tool – to navigate within the opened image

• Colour Manipulation – to view the histogram for the opened image and

manipulate individual channels or assign new colours to the image

• Uncertainty Visualisation – to visualise the uncertainty information

associated with a band shown in an image view

• World View – to see the position of our selected image

Navigation tool Colour Manipulation World View

19



To simultaneously view and compare multiple opened images, utilize the

Tile function (e.g. "Tile Horizontally" or „Tile Vertically“).

Ensure that the cursor is visible and that simultaneous manipulation of all

images is possible by navigating to the Navigation tab and verifying that

the following is checked:

synchronises views across multiple image windows

synchronises cursor positions across multiple image windows

One of the basic tools for image analysis in ESA SNAP is the

Optical/Spectrum View tool.

With this tool, we can display spectral curves of, for instance, water, soil,

and vegetation. Here we can see that vegetation has the highest intensity

of reflectance in the NIR band, while water is absorbed in the NIR band –

with no reflectance.
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For localization purposes, we can add various pins to different pixels and

add the description to them (View – Tool Windows – Pin Manager or by

clicking on the icon of Pin placing tool

To observe spectral information of these various pins, we can use the

tool Spectrum View
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In addition to providing users with data from its own Earth observing (EO)

satellites, the European Space Agency (ESA) has played a significant role

in providing access to Earth Observation missions not under ESA

ownership or operation—referred to as Third Party Missions (TPM). With a

history spanning over 45 years, the TPM program involves a series of

Earth Observation-focused satellites owned by various commercial and

public organizations worldwide. The TPM initiative currently includes over

50 missions, contributing data from more than 60 instruments to support

users engaged in research and development endeavors.

7.1. Access to TPM data

Users have the ability to explore and download Earth Observation (EO)

data from the extensive catalog of missions operated and supported by

the European Space Agency through the ESA EO Catalogue (EO-CAT):

• https://eocat.esa.int/sec/#data-services-area

User can find here:

 mission, instrument and product news and descriptions;

 collection descriptions;

 data access links;

 information on selected Earth/environmental topics and applications
of satellite data

Data are also accessible through the TPM L-OADS web interface:

• https://tpm-ds.eo.esa.int/collections/

For more information, see the lecture: 2. ESA EO Data Access and

resources, including Third Party missions, applications of Copernicus

Earth Observation data

7 | Third party missions

https://earth.esa.int/eogateway/missions/third-party-missions

THANK YOU FOR FOLLOWING THE EXERCISE!
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EXERCISE 3 – TUTORIAL

Key concepts of remote sensing data processing,

convert ing DN values to radiance and reflectance,

using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Convert Landsat 8 radiance to reflectance

 Calculate Land Surface Temperature at the Top of the Atmosphere
(TOA)

 Explore TOA temperatures within the area of interest

1

1 | Exercise outline



2 | Background

2.1 HOW TO CONVERT DNs TO PHYSICAL UNITS

Multispectral sensors usually capture reflected solar energy and rescale

this data into a digital number (DN) - a variable assigned to a pixel,

usually in the form of a binary integer the range of which depends on the

radiometric resolution; e.g. 0–255 (8-bit DNs) for Landsat ETM+. The

Landsat 8 OLI sensor is more sensitive so these data are rescaled into

16-bit DNs with a range from 0 and 65536.

DNs can be used directly for spectral index calculation or land cover

evaluation within a single scene. However, for comparing reflectance

between two or more scenes, it is necessary to convert DNs to surface

reflectance values. DNs do not directly express the values of a physical

quantity. For radiance values, it is necessary to recalculate DN values.

There are a number of spaceborne multispectral sensors to date

providing multispectral data in visible and thermal infrared spectrum

simultaneously. For our purpose of this exercise, we opted for the

Landsat-8 data that provide the highest possible spatial resolution of the

thermal band among the deployed missions on the Earth’s orbit. Also,

there is a favorable temporal coincidence with Sentinel 2 acquisitions

today that can be used for combined approach.

2



2.2 Study area and data used

For this exercise, we will use Landsat-8 L1 product (path 187, row 26, 29

September 2023, scene center time 9:26:47 GMT) for the study area of

Košice City, Slovakia, which was downloaded from the USGS

EarthExplorer website [@https://earthexplorer.usgs.gov/]. It contains

data recorded by two instruments - the Operational Land Imager (OLI)

and the Thermal Infrared Sensor (TIRS) with a spatial resolution of 30

meters for visible, near infrared and short-wavelength infrared bands

(bands 1-7, band 9), 15 meters for panchromatic band 8, and 100 by 30

meters for thermal bands 10 and 11. The data of thermal bands are

resampled to 30 by 30 meter pixels in the L1T product.

2.3 SNAP - Open and explore product

Open SNAP Desktop, click File – Import – Optical Sensors – Landsat –

Landsat8 in 30m (GeoTIFF) and open downloaded product

„LC08_L1TP_187026_20230929_20231003_02_T1“ by double click on

the metadata „LC08_L1TP_187026_20230929_20231003_02_T1_MTL

.txt“ inside the folder (or click on Import Product). The opened product

will appear in Product Explorer window.

3



Display product using e.g. True color composition: Right click on the

product – Open RGB Image Window – SNAP should automatically select

Landsat-8/9 L1 red,green,blue profile (using Red, Green, Blue band in

the corresponding red, green and blue color channels), resulting in a

natural colored result, that is a good representation of the Earth as

perceived by human eye. User can also explore Landsat-8 bands and

metadata.
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3.1 Conversion of DN values to TOA reflectance (without sun angle correction)

First, in SNAP we can display the Landsat-8 OLI band (raster) that we

want to convert to physical units, e.g. Band 4 (Red)

„LC08_L1TP_187026_20230929_20231003_02_T1_B4“. In Product

Explorer window expand Bands within your imported Landsat-8 product –

double click on „red“ (Band 4) to display selected band. We can have also

a look at the raster properties (right click on the raster – Properties).

3 | Top of Atmosphere Reflectance
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OLI sensor data (bands) can be converted to planetary reflectance at the

TOA (Top Of Atmosphere = TOA) using reflectance scaling coefficients

provided in the product metadata file (MTL file). The following equation is

used to convert Level 1 DN values to TOA reflectance for OLI data

without sun angle correction:

ρλ’ = Mρ * Qcal + Aρ

where:
ρλ' = TOA Planetary Spectral Reflectance, without correction for solar angle

Mρ = Band-specific multiplicative rescaling factor from the metadata

(REFLECTANCE_MULT_BAND_x from the metadata).

Aρ = Band-specific additive rescaling factor from the metadata

(REFLECTANCE_ADD_BAND_x from the metadata).

Qcal = Quantized and calibrated standard product pixel value in DN

The needed values to perform the conversion can be found in the Landsat

8 metadata file (LC08_L1TP_187026_20230929_20231003_02_T1_MTL

.txt) or by expanding and double click on Metadata information in SNAP.

After substituting the reflectance scaling coefficients provided in the

product metadata file, the equation to convert red band (Band 4) to

planetary reflectance at the TOA will be as follows:

ρλ’ = 2.0E-5 * red - 0.10000

Now go to Raster – Band Math and enter this expression to Band Maths

Expression Editor.
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Note that ρλ' is not true TOA Reflectance, because it does not contain a

correction for the solar elevation angle that is left out of the Level 1

scaling at the users' request; some users are content with the scene-

center solar elevation angle in the metadata, while others prefer to

calculate their own per-pixel solar elevation angle across the entire

scene.

Once a solar elevation angle is chosen, the conversion to true TOA

Reflectance (with sun angle correction) is as follows:

ρλ = 
𝜌𝜆’

𝑐𝑜𝑠(𝜃𝑆𝑍)
= 

𝜌𝜆’

𝑠𝑖𝑛(𝜃𝑆𝐸)

where:

ρλ = TOA planetary reflectance

θSE = Local sun elevation angle; the scene center sun elevation angle in

degrees is provided in the metadata

θSZ = Local solar zenith angle; θSZ = 90° - θSE

After substituting the local sun elevation angle provided in the product

metadata file (or calculating local solar zenith angle), the equation to

convert red band (Band 4) to true planetary reflectance at the TOA will

be as follows:

ρλ = ρλ’/sin(37.12281596)

Now go to Raster – Band Math and enter this expression to Band Maths

Expression Editor.
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True planetary reflectance at the TOA
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4.1 Conversion of DN values to TOA radiance

Images are processed in units of absolute radiance using 32-bit floating-

point calculations. These values are converted to 16-bit integer values in

the finished Level 1 product. They can then be converted to spectral

radiance using the radiance scaling factors provided in the metadata file.

The equation below is used to estimate TOA radiance:

Lλ = ML * Qcal + AL

where:

Lλ = TOA Spectral radiance (Watts/(m2 * srad * μm))

ML = Band-specific multiplicative rescaling factor from the metadata

(RADIANCE_MULT_BAND_x from the metadata, where x is the band

number)

AL = Band-specific additive rescaling factor from the metadata

(RADIANCE_ADD_BAND_x from the metadata, where x is the band

number)

Qcal = Quantized and calibrated standard product pixel value in DN

After substituting the variables in equation using provided metadata file,

the equation to convert red band (Band 4) to radiance at the TOA will be

as follows:

Lλ = 3.3420E-04 * thermal_infrared_tirs_(1) + 0.10000

By default, the S3TBX provides the TOA radiance of Landsat L1 data, but

you can switch to TOA reflectance by specifying a property.

Now go to Raster – Band Math and enter this expression to Band Maths

Expression Editor.

4| Top of Atmosphere Radiance
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TOA spectral radiance (Watts/(m2 * srad * μm))
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4.2 TIRS Top of Atmosphere Brightness Temperature

TIRS data can also be converted from spectral radiance (as described

above) to brightness temperature, which is the effective temperature

viewed by the satellite under an assumption of unity emissivity. The

following conversion formula is used to convert TOA radiance to TOA

brightness temperature:

T = 
K2

𝑙𝑛 (
K1
Lλ

+1)

where:

T = Top of atmosphere brightness temperature (K)

Lλ = TOA spectral radiance (Watts/(m2 * srad * μm))

K1 = Band-specific thermal conversion constant from the metadata

(K1_CONSTANT_BAND_x, where x is the thermal band number)

K2 = Band-specific thermal conversion constant from the metadata

(K2_CONSTANT_BAND_x, where x is the thermal band number)

After substituting the variables in equation using provided metadata file,

the equation to convert thermal band no. 10 (Band 10) to radiance at the

TOA will be as follows:

T = 
1321.08

ln (
774.89

Lλ
+1)
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Now you have converted the T

into degrees Kelvin. If you want to

convert this into Celsius, you need

to subtract 273.15 from the

degrees kelvin. For Fahrenheit,

multiply the degrees Celsius by

1.8 and then add 32. You can do

this as one step within the Band

Math function.
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Visualize by double click the final Top of Atmosphere Brightness

Temperature raster converted into Kelvin degrees. Change the colour

ramp to see diferrences better.

Explore the distribution of TOA temperatures within the city of Košice.

Compare it with, e.g. land cvoer map to see how different land

cover/land use correlate with these temperatures.

For more information, see the lecture: 3. Key concepts and physical

principles of remote sensing methods: electromagnetic energy, its

properties, spectral behaviour and interaction with the environment

THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_03.pdf


EXERCISE 4 – TUTORIAL

Optical remote sensing using ESA Copernicus´ data:

image metadata, image resolut ion (spectral, spatial,

temporal and radiometric resolut ion), color

composit ions and spectral indices, using SNAP

software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Gain understanding of image metadata and resolution concepts,
including spectral, spatial, temporal, and radiometric resolution,

and how these aspects influence data quality and usability

 Learn about optical remote sensing using data from the ESA's
Copernicus program. Key focus areas include the types of sensors

and platforms employed, from multi-spectral to hyper-spectral
instruments

 Explore practical examples of using Copernicus data for
environmental monitoring and management

1 | Exercise outline
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The exercise involves exploring Sentinel data products, specifically

focusing on optical Sentinel-2 imagery of the High Tatras, Slovakia,

obtained from the Dataspace Copernicus Open Access Hub.

Sentinel data products are distributed in a Sentinel-specific variation of

the Standard Archive Format for Europe (SAFE) format, containing

essential information about the imagery. This includes metadata, which

provides details such as acquisition time, sensor geometry, and geographic

location. Utilizing SNAP software, users can access and browse this

metadata.

The spatial resolution of satellite imagery, crucial for discerning details on

Earth's surface, varies across bands, with higher resolutions capturing

finer details. Sentinel-2 bands offer different spatial resolutions tailored to

specific features, enabling effective Earth observation. Spectral resolution

refers to a sensor's ability to distinguish between wavelengths, with

Sentinel-2's Multi-Spectral Instrument (MSI) capturing imagery across 13

spectral bands. Radiometric resolution, denoting the level of detail

encoded in each pixel, is vital for discerning subtle variations in energy.

Sentinel-2 boasts a radiometric resolution of 12 bits per pixel, enhancing

its capacity for precise data capture. Temporal resolution, dictating how

frequently a satellite revisits and captures images of the same area, is

significant for monitoring environmental changes over time. Sentinel-2

satellites provide a combined revisit time of approximately 5 days,

facilitating timely responses to dynamic environmental conditions.

Additionally, the exercise involves creating colour compositions and

spectral indices like NDVI from the Sentinel-2 product to assess vegetation

health. This comprehensive approach enables users to gain insights into

Earth's dynamics and environmental parameters for various applications,

including precision agriculture and disaster monitoring.

2 | Background
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Sentinel data products refer to a directory folders that contain a collection

of information and are distributed using a Sentinel-specific variation of the

Standard Archive Format for Europe (SAFE) format specification. It

includes:

• A product metadata file in XML format, detailing the physical structure

and content of the product (e.g. MTD_MSIL2A).

• A manifest.safe file, which contains general product information in XML

format.

• A DATASTRIP subfolder containing information at the datastrip level.

• A GRANULE subfolder containing image data (granules/tiles) in

JPEG2000 format, along with quality indicators such as quality masks

and reports.

• An AUX_DATA subfolder containing auxiliary files that may be embedded

in the product.

• A rep-info subfolder containing XSD schemas describing the product

components.

• An INSPIRE XML file, which is a metadata file based on the INSPIRE

Metadata regulation.

• An HTML subfolder containing a product presentation file for easy

display of the main content of the product.

3 | Image metadata
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Navigate to the folder for this exercise and take a look at the structure of

the Sentinel-2 product yourself.

Metadata, as commonly understood, refers to "data about the data." In

the context of satellite imagery, metadata refers to the information

describing these images, including details such as the time of acquisition,

the geometry of the sensor at that time, the specific geographic location

depicted in the image.

Double-click on „MTD_MSIL2A“ file inside Sentinel-2 product to open it
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3.1. SNAP - Open and explore product

We can also open the metadata using SNAP software and browse them.

For this exercise, we will use Sentinel-2 L2A image of the High Tatras,

Slovakia, downloaded from the Dataspace Copernicus Open Access Hub

[@https://dataspace.copernicus.eu/].

On the Copernicus dataspace website, metadata can be found next to

each searched product. Clicking on the information icon displays a more

detailed preview of each product

5
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Open SNAP Desktop, click Open Product and open downloaded product

(unzipped) by double click on the metadata „MTD_MSIL2A.xml“ inside

the folder. The opened products will appear in Product Explorer window.

S2A_MSIL2A_20220519T094041_N9999_R036_T34UDV_20230103T005625.SAFE

To access the metadata information within the product, double-click on the

product in the Product Explorer to reveal the directories – open Metadata

direcory – select Level-2 User Product by double click on it, so it opens in

a new window. Explore the basic information on image product.

To obtain information on granules, e.g. sensing time, projection,

coordinates, etc. Visualize also granules for the tile.
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Resolution influences the usability of data collected by a sensor, and it can

differ based on factors such as the satellite's orbit and sensor

configuration. When evaluating a dataset, it's important to consider four

types of resolution: spatial, spectral, radiometric and temporal.

Spatial resolution

Spatial resolution is defined by the size of each pixel within a digital image

and the area on Earth’s surface represented by that pixel.

For instance, most bands captured by the Moderate Resolution Imaging

Spectroradiometer (MODIS) possess a spatial resolution of 1 km, with each

pixel representing a ground area of 1 km x 1 km. Additionally, MODIS

includes bands with finer spatial resolutions of 250 m or 500 m. A lower

number indicates a finer resolution, allowing for greater detail to be

discerned. In the provided image, you can observe the variance in

pixelation between a 30 m/pixel image (left), a 100 m/pixel image

(center), and a 300 m/pixel image (right).
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To check the spatial resolution of the Sentinel-2 bands, open Metadata

direcory – select General info under Level-2 User Product by double click

on it, so it opens in a new window. Go to Product Image Characteristics –

Spectral Information and have a look at spectral wavelenghts and

resolutions of individual bands.

The spatial resolution of Sentinel-2 bands varies depending on the specific

spectral band. Sentinel-2 offers a variety of spectral bands with different

spatial resolutions:

The different spatial resolutions of Sentinel-2 bands serve specific purposes

and are determined based on the requirements of different applications

and the characteristics of the Earth's surface.
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To explore the spatial resolution of the Sentinel-2 bands, you can visualize

individual bands – you can open e.g. B4 (10m spatial resolution), B8A

(20m spatial resolution), B9 (60m spatial resolution) by double-click on

each of these bands in Bands folder. Then, tile windows Horizontally and

zoom into the image to see different spatial resolutions.

It's important to note that the spatial resolution of each band determines

the level of detail captured in the imagery, with higher spatial resolutions

providing finer details.

The spatial resolution of Sentinel-2 bands varies to optimize the sensor's

ability to capture specific features on the Earth's surface, with higher

resolutions (e.g., 10 meters per pixel) suited for detailed features like

urban areas, and lower resolutions (e.g., 60 meters per pixel) for broader-

scale observations. Trade-offs between spatial resolution and factors like

spectral range and cost are necessary due to design limitations, balancing

the sensor's capabilities to provide comprehensive Earth observation data.

Despite the complexity and cost associated with higher resolutions,

Sentinel-2's diverse spatial resolutions enable it to meet various Earth

observation needs effectively.
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Spectral resolution

Spectral resolution refers to a sensor's capacity to distinguish between

finer wavelengths, typically achieved by having more and narrower bands.

Many sensors are classified as multispectral, featuring 3-10 bands, while

others, known as hyperspectral sensors, offer hundreds to even thousands

of bands. The narrower the wavelength range for a specific band, the

higher the spectral resolution.

Sentinel-2 satellites have a multispectral instrument called the Multi-

Spectral Instrument (MSI) that captures imagery in 13 spectral bands,

ranging from visible to near-infrared and shortwave infrared wavelengths.
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Spectral resolution

To check the spatial resolution of the Sentinel-2 bands, open Metadata

direcory – select General info under Level-2 User Product by double click

on it, so it opens in a new window. Go to Product Image Characteristics –

Spectral Information and have a look at spectral wavelenghts of individual

bands.

The spectral resolution of these Sentinel-2 bands ranges from 10 to 60

meters. This means that the sensors can differentiate between different

wavelengths of light within these ranges. This high spectral resolution

allows for the characterization of various features on the Earth's surface,

such as vegetation health, land use and land cover, water quality, and

more. Additionally, the combination of high spectral and spatial resolution

in Sentinel-2 data makes it valuable for a wide range of applications in

agriculture, forestry, environmental monitoring, urban planning, and

disaster management.

Rigth click on the Sentinel-2 product to open RGB Image Window – select

Sentinel 2 MSI Natural Color composition. Double click on the individual

bands to visualize it. Tile Windows Horizontally and zoom in to explore in

detail.
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Visualize the bands to understand their common applications – double-click

on each individual band to View it in the new window:

Near Infrared (NIR) band (Band 8) is highly sensitive to chlorophyll

content in vegetation, making them useful for monitoring vegetation

health, estimating biomass, and detecting changes in plant vigor. It can be

also used to detect and analyze urban heat islands, as urban areas often

have different thermal properties than surrounding natural environments.

Red, Green, and Blue bands (Bands 2, 3, and 4) are commonly used

for traditional RGB (Red-Green-Blue) imaging, which allows for visual

interpretation and classification of different land cover types.

Coastal Aerosol band (Band 1) is particularly sensitive to changes in

water turbidity and sediment concentrations in coastal regions, making it

useful for monitoring water quality.

Shortwave Infrared (SWIR) bands (Bands 11 and 12) along with NIR

band are sensitive to changes in snow and ice reflectance and can be used

to monitor snow cover extent, snow melt, and ice dynamics.

Red Edge bands (Bands 5, 6, and 7) are sensitive to changes in

chlorophyll content and leaf structure, making them useful for detecting

vegetation stress caused by factors such as disease, drought, or nutrient

deficiency.
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Radiometric resolution

Radiometric resolution refers to the level of detail encoded in each pixel,

specifically, the number of bits used to represent the recorded energy.

Each bit corresponds to an exponent of power 2. For instance, an 8-bit

resolution equals 2^8, offering 256 potential digital values (ranging from 0

to 255) to capture information. Consequently, higher radiometric resolution

provides a greater range of values to store data, enhancing the ability to

discern even minor differences in energy. For example, in assessing water

quality, radiometric resolution is crucial for distinguishing subtle variations

in ocean color.

The radiometric resolution of Sentinel-2 refers to the ability of its sensors

to capture and represent the intensity of electromagnetic radiation (light)

across its spectral bands. Sentinel-2 has a radiometric resolution of 12 bits

per pixel.

A 12-bit radiometric resolution means that each pixel in the imagery

captured by Sentinel-2 can represent 2^12 (4096) different levels of

brightness or intensity. This high radiometric resolution allows for the

detection of subtle variations in reflectance across the Earth's surface,

which is crucial for applications such as land cover classification, vegetation

monitoring, and change detection.
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Temporal resolution

The temporal resolution of satellite refers to how frequently the satellite

revisits and captures images of the same area on the Earth's surface.

Sentinel-2 satellites operate in a polar sun-synchronous orbit, which means

they pass over the same area at approximately the same local solar time

on each orbit.

Polar orbiting satellites have a temporal resolution that can vary from 1

day to 16 days. For example, the MODIS sensor aboard NASA's Terra and

Aqua satellites has a temporal resolution of 1-2 days, allowing the sensor

to visualize Earth as it changes day by day. The Operational Land Imager

(OLI) aboard the joint NASA/USGS Landsat 8 satellite, on the other hand,

has a narrower swath width and a temporal resolution of 16 days; showing

not daily changes but bi-monthly changes.

Today, Sentinel-2A and Sentinel-2B provide a combined revisit time of 5

days at the equator with a 10-day revisit time at higher latitudes. This

means that for any given location on the Earth's surface, Sentinel-2

captures imagery approximately every 5 days, on average. However,

frequent cloud cover or other atmospheric conditions may affect the

availability of cloud-free imagery. The frequent revisit time of Sentinel-2

data is valuable for monitoring changes in land cover, vegetation dynamics,

and other environmental parameters over time, allowing for timely

responses to natural disasters, agricultural monitoring, and other

applications that require up-to-date information about the Earth's surface.
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5.1 Color compositions

Satellites equipped with sensors observe Earth's surface by measuring the

electromagnetic radiation reflected or emitted from it. These sensors,

known as multispectral sensors, capture data across various regions of the

electromagnetic spectrum simultaneously, including visible light, near-

infrared, and short-wave infrared. Each portion of the spectrum measured

by a sensor is referred to as a band, typically defined by its wavelength.

Multispectral images can be viewed either as single-band grayscale images

or as color composite images, combining information from three bands at a

time. These three bands correspond to the primary colors of light: red,

green, and blue. Computer screens can display images by representing

each band with a different primary color, enabling the creation of color

composite images by combining these three separate images.

Natural or True Color Composites

A natural or true color composite combines visible red, green, and blue

bands to resemble what would be observed naturally by the human eye.

This composite replicates natural appearances, with vegetation appearing

green, water as blue to black, and bare ground and surfaces in light grey

or brown tones. While favored for their natural color representation, true

color compositions may lack contrast and clarity due to atmospheric blue

light scattering, making subtle features challenging to discern.

False Color Composites

False color images are a representation of a multi-spectral image produced

using bands other than visible red, green and blue as the red, green and

blue components of an image display. False color composites allow us to

visualize wavelengths that the human eye can not see. Using bands such

as near infra-red increases the spectral separation and interpretability of

the data. There are many different false colored composites which can

highlight many different features. See the heading below for more

information about common band combinations for false color composites.
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Open image as RGB color composition

Display image in Natural Colors

(as seen by human eye)

Open image in False Colors or open as 

an Atmpospheric penetration image
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To display product using e.g. True color composition: Right click on the

product – Open RGB Image Window – SNAP should automatically select

Landsat-8/9 L1 red,green,blue profile (using Red, Green, Blue band in

the corresponding red, green and blue color channels), resulting in a

natural colored result, that is a good representation of the Earth as

perceived by human eye. User can also explore Landsat-8 bands and

metadata.
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To display multiple options of color compositions, it is necessary to

resample the data to the same spatial resolution.

Navigate to the Main Menu: Raster – Geometric – Resampling

In the I/O Parameters tab select the source product and set the name for

the target product

In the Resampling Parameters set B2 as the band used to resample all

other bands of the product and click RUN.

Right click on the resulted product

in the Product Explorer tab – Open

RGB Image Window. Now that we

have resampled all bands to the

same spatial resolution, it is

possible to create many more color

compositions.



4.2 Spectral indices

Radiometric spectral indices are quantitative measures of features that are

obtained by combining several spectral bands, features that are not

otherwise obvious if using only one band. there are many others developed

for specific applications and environmental parameters.. The indices

provided with Sentinel-2 Toolbox, detailed below, are grouped into three

categories:

- Vegetation indices

- Soil indices

- Water indices

These are commonly used spectral indices:

• Normalized Difference Vegetation Index (NDVI) is calculated from

the red and near-infrared bands of satellite imagery and is widely used

to assess vegetation health, biomass, and photosynthetic activity.

• Normalized Difference Water Index (NDWI) is calculated using the

green and near-infrared bands and is used to detect the presence of

water bodies and monitor changes in water content in vegetation.

• Normalized Burn Ratio (NBR) is used to detect and assess the

severity of burned areas after wildfires by comparing near-infrared and

shortwave infrared bands.

Let´s create, e.g. NDVI from our Sentinel-2 product:

The Normalized Difference Vegetation Index (NDVI) algorithm exploits the
strength and the vitality of the vegetation on the earth's surface. It is
calculated from the visible and near-infrared light reflected by vegetation.

Even if it is an old and classic method it is still much used to estimate the

health of green vegetation and post processed high definition images for
precision agriculture.

• Vegetation has high NIR and low Red reflectance

• Other land cover have NIR and Red which are much close together

• vegetation from 0.3 to 0.8, depending on health/intensity

• water (sea, lakes, rivers) low positive or even negative

• bare soil low positive values from 0.1 to 0.2
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Navigate to the Main menu – Optical – Thematic Land Processing –

Vegetation Radiometric Indices – NDVI Processor

User can also use Band Maths option to create vegetation indices:

• Select the subset product in the Product Explorer window.

• Click on ‘Raster’ - ‘Band Maths…’

In the pop-up window set up the parameters as shown in the Figures:

Change the Name: ‘NDVI’

Unselect ‘Virtual’ box

Click on ‘Edit Expression…’

Create your expression using ‘@’ and after replace them with the bands

(@ - @) / (@ + @)

(B8 – B4) / (B8 + B4)

Click on ‘OK’ and ‘Run’
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To explore the final NDVI layer values of the Sentinel-2 product: double-

click on the NDVI layer in Bands folder. Then, you can select in the Colour

manipulation tab one of the palettes to visualize the resulted raster better.

Explore the NDVI values on the image:

NDVI values typically range from -1 to 1, although in practice, they often

fall within a narrower range, typically from -0.1 to 0.9. Here's what these

values generally represent:

• Negative Values (-1 to 0): usually indicate non-vegetated surfaces such

as water bodies, barren land, or built-up areas. These surfaces absorb

more visible light and reflect less near-infrared light.

• Values Around Zero (0 to 0.1): Values close to zero represent surfaces

such as bare soil, rocks, or urban areas with sparse vegetation cover.

They reflect similar amounts of visible and near-infrared light.

• Low Values (0.1 to 0.3): Low positive values indicate areas with sparse

or stressed vegetation cover, such as shrublands, savannas, or recently

harvested fields.

• Moderate Values (0.3 to 0.6): Moderate positive values typically

represent healthy vegetation, including grasslands, forests, and

croplands with good vegetation cover.

• High Values (0.6 to 0.9): High positive values correspond to dense and

vigorous vegetation cover, such as dense tropical rainforests or highly

productive agricultural fields.

For more information, see the lecture: 4. Optical remote sensing using

ESA Copernicus´ data: sensors and platforms, image metadata, image

resolution (spectral, spatial, temporal and radiometric resolution)

20

THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_04.pdf


EXERCISE 5 – TUTORIAL

Basics of Radar Remote Sensing - data processing,

using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Learn the basic physics of SAR interferometry

 Perform necessary data processing for making an interferogram

 Understand the information content in SAR interferometric images

1 | Exercise outline

1

Morocco earthquake deformation
Source: contains modified Copernicus Sentinel data (2023), processed by 

Aristotle University of Thessaloniki and the DIAPASON InSAR service of CNES 
integrated by TRE Altamira on the Geohazard Exploitation Platform GEP/ESA.



Deformation Mapping and Change Detection using Sentinel-1 data

One of the mission's primary functions is to regularly monitor subtle

alterations in the Earth's surface elevation. During an earthquake event,

surface changes are notably more conspicuous compared to gradual

movements such as subsidence or uplift. These radar images enable

scientists to meticulously observe and analyze the specific impacts of

earthquakes on the Earth's land surface.

On Friday 8 September 2023, the powerful 6.8 magnitude earthquake

struck the Atlas Mountains, about 75 km from Marrakech. Tragically, the

earthquake resulted in a significant loss of life, widespread building and

home collapses, and the blockage of roads. Its impact extended to the

extent that buildings even swayed on the country's northern coast.

In response to the Moroccan earthquake, the Copernicus Emergency

Mapping Service was mobilized to facilitate the exchange of satellite data.

2 | Background

Satellites constantly monitor

Earth from space, providing vital

data essential for rapid damage

assessment and disaster

management. The radar on

board the Copernicus Sentinel-1

mission can detect ground

conditions and penetrate clouds,

functioning day and night.

2



2.1 Study area and data used

For this exercise, we will use two Sentinel-1 SLC images of the same area

near Marrakech, Morocco, downloaded from the Dataspace Copernicus

Open Access Hub [@https://dataspace.copernicus.eu/].

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 2 downloaded products

by double click on the zipped folders. The opened products will appear in

Product Explorer window.

S1A_IW_SLC__1SDV_20230830T062919_20230830T062946_050101_06076B_20BE.SAFE.zip

S1A_IW_SLC__1SDV_20230911T062920_20230911T062947_050276_060D5E_D10D.SAFE.zip

To access the information within the product, double-click on it to reveal

the directories, which include:

• Metadata: containing parameters pertaining to orbit and data.

• Tie Point Grids: providing interpolation data for latitude/longitude,

incidence angle, etc.

• Quicklooks: presenting a visible image of the entire scene in radar

coordinates.

• Bands: consisting of complex values for each subswath "i" and "q",

along with intensity (where intensity represents the squared amplitude

and functions as a virtual band).

Select intensity image for swath IW1 VV – double click on it to View it

Note: Each SAR image is flipped north—south it maintains the same

orientation as its acquisition (in this case, ascending track).
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3.2 Coregistration

Image coregistration is the process that involves aligning two or more

images geometrically, ensuring that corresponding pixels depict the same

area on the Earth's surface. While orbit state vectors alone can suffice to

coregister images, for precise offset tracking, additional data from a digital

elevation model (DEM) is necessary to enhance coregistration accuracy.

Navigate to Main Menu – Radar – Coregistration –S1 TOPS Coregistration –

S1 TOPS Coregistration

In the Read tab, select the 20230830 SLC product and in the Read(2) tab

select the 20230911 SLC product

In TOPSAR-Split and TOPSAR-Split(2) tabs select Subswath: IW1

Polarizations:VV

In the Apply Orbit File tab select leave default parameters and uncheck „Do

not fail if new orbit is not found“ option

In the Write tab, select the directory to save your processing outputs
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3.3 Forming a Raw Interferogram

The next phase of interferometry involves generating an interferogram

using the coregistered SLC images. To do this, follow these steps:

From the main menu bar, go to Radar – Interferometric - Products and

finally select Interferogram Formation.

In the I/O Parameters tab, choose the "Orb_Stack" product that was

generated during the coregistration process.

By default, the output target is set to the same directory and appends "ifg"

to the filename.

For standard processing, there's no need to modify the defaults in the

Processing Parameters tab.
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Raw Interferogram — Phase Image should appear int he View tab.

3.4 TOPS Debursting and Topographic Phase Removal

The next stage in interferometry using Sentinel-1 TOPS mode (IWS) data

involves "debursting" or merging the bursts, a step not required with

Sentinel-1 or other stripmap SAR data.

To perform debursting, follow these steps:

From the main menu bar, navigate to Radar, then Sentinel-1 TOPS, and

finally S-1 TOPS deburst.

In the I/O Parameters tab, choose the "Orb_Stack_ifg" product generated

during the interferogram formation process. By default, the output

appends "deb" to the filename.

There is no need to make changes in the Processing Parameters tab.
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The subsequent stage in all interferometry processes involves eliminating

the topographic phase using a Digital Elevation Model (DEM).

To proceed with topographic phase removal, follow these steps:

From the main menu bar, navigate to Radar, then Interferometric, then

Products, and finally Topographic Phase Removal.

In the I/O Parameters tab, choose the "Orb_Stack_ifg_deb" product

generated during the deburst step. If not using TOPS mode, select

"Stack_ifg" instead.

By default, the output appends "dinsar" to the filename.

The Processing Parameters tab indicates that the default setting is to

download the SRTM 3-arcsecond DEM, which is suitable for basic

processing. However, in certain cases, you may require a different DEM.

Viewing Differential Interferogram — Phase Image
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3.5 Filtering and Multi-Looking Interferogram

There are two methods to minimize noise in the interferogram: filtering

and multi-looking. While our standard procedure involves applying filtering

initially, it's also possible to opt for multi-looking first.

To begin filtering:

Go to Radar, then Interferometric, then Filtering, and select Goldstein

Phase Filtering from the top main menu bar.

In the I/O Parameters tab, choose the "dinsar" product generated in the

previous step.

By default, the output name includes "flt."

There's no necessity to adjust the default settings in the Processing

Parameters tab for basic processing.

3.6 Multi-Looking Interferogram

Multi-looking involves averaging several pixels in each direction, a process

referred to by radar engineers as "taking multiple looks." This leads to

larger pixels and has the potential to significantly diminish noise.

The extent of multi-looking required depends on the desired spatial

resolution and the spacing of the fringes.

The Morocco earthquake, with a depth of approximately 18 km, exhibits

widely spaced fringes. Additionally, there is no surface rupture, allowing for

increased spatial averaging without sacrificing the earthquake signal.

8



To initiate multi-looking:

From the top main menu bar, select Radar, then SAR Utilities, and finally

Multilooking.

In the I/O Parameters tab, choose the "dinsar_flt" product generated by

the filtering step. By default, "ML" is appended to the output name.

In the Processing Parameters tab, select the Source Bands "i_ifg", "q_ifg",

and "coh". For this scene, 17 range looks are utilized, with the calculation

of 5 azimuth looks resulting in approximately 70 m output pixels.

Do not select the "Phase" band.

9

Viewing Multi-Looked Interferograms

Initially, we must generate a new virtual

phase band after multi-looking the

complex interferogram.

To do this:

From the top main menu bar, navigate to

Raster, then Data Conversion, and select

Complex i and q to Phase.

Subsequently, you can display the newly

created phase band.

As a result of this process, the fringes

exhibit significantly reduced noise, and the

aspect ratio has been modified, resulting in

pixels that are approximately square on

the ground. The new image now measures

considerably smaller number of pixels than

the original image.



3.7 Phase Unwrapping

Unwrapping in SNAP follows three distinct steps:

1. Export of the wrapped phase (and definition of the parameters)

2. Unwrapping of the phase (performed outside SNAP by snaphu)

3. Import of the unwrapped phase back into SNAP

Export of the wrapped phase

Export your interferogram or your subset interferogram from Sentinel-1

Toolbox to SNAPHU:

From the top main menu bar, navigate to Radar > Interferometric >

Unwrapping > Snaphu Export.

In the Snaphu Export window:

In Read tab, select the “ML” product created by the multilooking step

In Snaphu Export tab, you also need to specify a target folder for exported

files. Create a new target folder for this step by entering a path and new

folder name (e.g. „snaphu_export). If the selection of the directory does

not work, simply copy and paste the path of your working directory into

the text field.

In Snaphu Export tab, select DEFO as Statistical-cost mode

Select MCF.

Note: You can also change the number of tile rows, columns and number of

processors to e.g. “1” because we don’t need multiple tiles after

multilooking or select 200 pixels for Row Overlap and Column Overlap if

you want to multilook. Depending on the number of processors of your

computer, you can also increase the Number of Processors variable.

Click Run to create the SNAPHU_Export file

The folder now holds files used for phase unwrapping.
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3.7 Phase Unwrapping

Unwrapping in SNAP follows three distinct steps:

1. Export of the wrapped phase (and definition of the parameters)

2. Unwrapping of the phase (performed outside SNAP by snaphu)

3. Import of the unwrapped phase back into SNAP

Export of the wrapped phase

Export your interferogram or your subset interferogram from Sentinel-1

Toolbox to SNAPHU:

From the top main menu bar, navigate to Radar > Interferometric >

Unwrapping > Snaphu Export.

In the Snaphu Export window:

In Read tab, select the “ML” product created by the multilooking step

In Snaphu Export tab, you also need to specify a target folder for exported

files. Create a new target folder for this step by entering a path and new

folder name (e.g. „snaphu_export). If the selection of the directory does

not work, simply copy and paste the path of your working directory into

the text field.

In Snaphu Export tab, select DEFO as Statistical-cost mode

Select MCF.

Note: You can also change the number of tile rows, columns and number of

processors to e.g. “1” because we don’t need multiple tiles after

multilooking or select 200 pixels for Row Overlap and Column Overlap if

you want to multilook. Depending on the number of processors of your

computer, you can also increase the Number of Processors variable.

Click Run to create the SNAPHU_Export file

The folder now holds files used for phase unwrapping:

▪ the coherence: image (*.img) and metadata (*.hdr)

▪ the wrapped phase: image (*.img) and metadata (*.hdr)

▪ the unwrapped phase: only the metadata (*.hdr), because the image

(*.img) is first to be created

by snaphu in the next step.

▪ a configuration file (snaphu.conf) containing the parameters defined in

the export operator
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Unwrapping of the phase

You should see the wrapped interferogram phase “Phase_ifg*.img”,

coherence “coh_*.img”, and a “snaphu.conf” file.

For the next step, you will need to instal SNAPHU in Windows. SNAPHU is a

tool for phase unwrapping of interferometric information. To use it as an

executable file (*.exe) in Windows it has to be compiled first so all required

drivers (*.dll) are installed correctly. Follow the steps for installation here:

file:///C:/Users/Ona%C4%8Dillov%C3%A1/Downloads/Installation_SNAPH

U_English_ABraun.pdf

To start unwrapping, check the location of the interferogram exported from

SNAP. If snaphu.exe is not in your system’s PATH variable: Copy it in there

as well. It is recommended to store the data and snaphu on the same disk.

Open Command Window Here.

Type snaphu and hit Enter. The help menu should be displayed.

The command to start the unwrapping is shown in the file snaphu.conf.

Open it with a text editor. The beginning of the “snaphu.conf” file shows

the command to call Snaphu
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The Snaphu program can take a long time to run. At the end it writes

unwrapped phase to “Unw_ifg*.img” file

Import of the unwrapped phase

Now, we import the unwrapped phase. From the top main menu bar, select

Radar > Interferometric > Unwrapping, and then Snaphu Import that

converts it back into the BEAM DIMAP format and adds the required.

Read-Phase: should be set to the wrapped product that you

exported(before the export)

Read-Unwrapped-Phase: select the unwrapped phase product: Navigate to

folder where you exported for Snaphu. Select the

“UnwPhase_ifg*.snaphu.hdr” file. Note: The error message will then vanish

if you proceed to the next tab.

SnaphuImport: Leave the option “Do NOT save Wrapped interferogram in

the target product”

unchecked, because it is required in the later step.

Write: To store the imported unwrapped band in a separate product

(recommended), add ‘_unw’ to the end of the output name and click Run.

Finally, a new product is added to the Product Explorer which contains the

the unwrapped phase that we can display.
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Select the Unw_Phase_ifg band. Double click on this unwrapped phase to

see if the unwrapping was successful. It should be a smooth raster with

little variation except for the areas of expected deformation.

All fringe patterns are summarized to absolute changes. Go to the Colour

Manipulation tab and select “100%” to stretch color scale to full range of

unwrapped data. Unwrapped phase is still in radians. Phase is reference

image minus coregistered image. If reference image is earlier, then

negative phase is land moving toward satellite (negative range change)
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3.8 Phase to displacement

We can convert the unwrapped phase to displacements. From the top main

menu bar, select Radar, then Interferometric, then Products, and then

Phase to Displacement.

The I/O Parameters tab should be set to the unwrapped product that you

imported.

Default for target product name is to add “_dsp” to the name

Now, we can display displacement band of result. Again, better to stretch

colors. Displacements is now in meters.

Sign was changed so positive displacement is “up” towards satellite

3.9 Geocoding results—Terrain Correction

SNAP calls geocoding with topography “Terrain Correction.” From the top

main menu bar, select Radar, then Geometric, then Terrain Correction, and

then Range-Doppler Terrain Correction.

The I/O Parameters tab should be set to the displacement product that you

imported (or one of the other ML products).

default for target product name is to add “_TC” to the name

Under Processing Parameters tab, select the Source Bands and any

additional Output Bands. You can also choose what DEM to use, output

spacing, and map projection.

Now, we can display displacement_vv band of geocoded result. Again,

better to stretch colors.

Displacements in meters with positive values “up” towards satellite in Line-

of-Sight direction.

Product is now evenly spaced in latitude and longitude.
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3.10 Displacement Profiles

Use the line drawing tool (top bar of SNAP window) to draw a line across

the signal. Run Analysis>Profile Tool to see displacement along the profile

Remember that InSAR displacements are relative. In this case,

displacement far from the signal is about -0.1 m, so that is probably the

“true zero” offset. Maximum is about 0.24 m, but we need to subtract zero

offset to get total displacement of about 0.35 m

For more information, see the lecture: 5. Basics of Radar Remote Sensing

- principles and applications
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EXERCISE 6 – TUTORIAL

Precision agr iculture mapping – dig ital image

analyses using Sentinel-2 mult ispectral data, image

classificat ion, comparison with UAV mult ispectral

data, using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Delve into the use of Copernicus multispectral data in optimizing
agriculture mapping

 Explain how to use Sentinel-2 data to monitor plant health and soil
conditions

 Learn to process and interpret this data, using indicators like the
Normalized Difference Vegetation Index (NDVI) and the Normalized
Difference Moisture Index (NDMI)

 Compare Sentinel-2 outputs with high-resolution UAV multispectral
data

1 | Exercise outline
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Precise agriculture using Sentinel-2 data

Sentinel-2 satellites are instrumental in precision agriculture due to their

ability to provide detailed and frequent multispectral imagery. These

images offer valuable insights into crop health, soil moisture, and

vegetation growth, enabling farmers to optimize their agricultural

practices. In precision agriculture, commonly used indices derived from

Sentinel-2 satellite imagery include:

• NDVI: Measures vegetation health and vigor based on near-infrared and

red light reflectance.

• EVI: An improved version of NDVI that corrects for atmospheric effects

and provides better sensitivity to vegetation changes.

• SAVI: Adjusts NDVI to account for soil brightness, improving accuracy in

areas with sparse vegetation.

• NDWI: Quantifies water content in vegetation and soil, aiding in soil

moisture monitoring and water stress detection.

• LAI: Measures leaf area per unit ground area, providing insights into

vegetation density and biomass accumulation.

These indices help farmers and land managers monitor crop health,

predict yields, and make informed decisions for optimal agricultural

practices.

2 | Background

2

Source: https://eos.com/blog/precision-agriculture/



2.1 Study area and data used

For this exercise, we will use three Sentinel-2 images of the same area in

Šarišské Bohdanovce, Slovakiia, using the Tile Number *34UEV*

downloaded for four time intervals in 2016 from the Dataspace

Copernicus Open Access Hub [@https://dataspace.copernicus.eu/]. At

the end of this exercise, we will compare these Sentinel-2 data with UAV

data acquired in September 2016.

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 4 downloaded products

(unzipped) by double click on the metadata „MTD_MSIL2A.xml“ inside

the folder. The opened products will appear in Product Explorer window.

S2A_MSIL2A_20160407T093032_N0213_R136_T34UEV_20210228T161314.SAFE

S2A_MSIL2A_20160629T094032_N0213_R036_T34UEV_20210228T170703.SAFE

S2A_MSIL2A_20160927T094032_N0213_R036_T34UEV_20210228T181146.SAFE

Display all products side by side using e.g. Atmospheric penetration band

combination: Right click on the product – Open RGB Image Window –

select Sentinel 2 MSI Natural colors. Repeat this step also for other two

products.
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Then, tile windows horizontally. By opening and displaying all 4 images at

once, we can take a first visual interpretation of agriculture fields in 2016

- from the left.

In Navigation tab – Synchronise views across multiple image windows –

Zoom into the eastern part of the image to explore deforestation.

2.3 Create Processing Graph

Then, we need apply the same pre-processing steps for all our scenes.

However, processing the data step by step and product by product could

be time-consuming and impractical. Fortunately, the Batch Processing

tool in SNAP allows us to apply all the steps to both images

simultaneously, saving both time and disk space since only the final

product is physically stored.

To use the tool, the initial step is to define the process we intend to apply

along with all its corresponding steps. This can be accomplished by

utilizing the GraphBuilder tool. Therefore, let's build our graph by

navigating to Tools → GraphBuilder. Through the GraphBuilder

function, we build a processing graph, outlining the specific order of

processing steps:

4



At the beginning, the graph has only two operators: Read (to read the

input) and Write (to write the output). To add the new operator right-

click the white space between the existing operators and select the

desired operators:

• Subset – export only bands that we will need for further analysis to

calculate NDVI, GNDVI, GRVI – select only B3, B4 and B8

• Band Maths – to calculate NDVI, GNDVI, GRVI using slected bands

• Band Merge – to combine the resulting bands into the resulting file

For the moment, do not change anything in the parameter tabs and save

the graph (File – Save Graph) as „Graph_precision_agriculture.xml“ to

your working folder. After you have saved it, close the GraphBuilder

window.

2.4 Batch Processing

Open the Batch Processing tool (Tools → Batch Processing).

We will add all opened products by clicking Add Opened on the upper

right (second icon from the top). Then, we delete original = not

projected products by sleecting them and clicking Delete (third icon from

the top left only reprojected products). Then, when we have only 4

reprojected products, we click File - Load Graph at the top of the

window and navigate to our saved graph „Graph_Deforestation“ and

open it. We see that new tabs have appeared at the top of window

corresponding to our operators with the exception of Read; this is correct

as these parameters will be set in the I/O Parameters tab.
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In the next step it is advisable to create Subset of these products for

faster processing:

• Source bands – select only bands that we will need to calculate NDVI

– B3, B4 and B8

• Geographic Coordinates – create the subset of the area also by

clicking on zoom into the area of image (red rectangle) and draw

smaller (yellow) polygon inside it that includes only eastern part of the

images where we observed deforestation

• Reference band – select Reference band according which all the

Source Bands will be resampled

In BandMath, we firstly enter the formula for NDVI calculation. The NDVI

is calculated as a normalized difference of visible infrared (B8) and visible

red (B4) bands, using the following equation (Rouse et al. 1974):

(B8-B4)/(B8+B4)

Then, in BandMerge tab we can combine the resulting bands into the

resulting file and set the directory for the output file in Write tab. The

common processing can be monitored. Writing target product may take

some time.



3.1. NDVI analysis

Open the output NDVI images side by side for all processed years –

Window – Tile Horizontally. In Colour Manipulation select Colour ramp

derived from meris pressure.

NDVI image - has values from ˂ -1, 1 ˃, where forested areas are

displayed in values higher than 0. The peaks of the histogram point to 2

extremes - forested and logged area.
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The highest NDVI values occurs in

the summer season – June - during

periods of peak vegetation growth

and vigor. NDVI values tend to

increase as vegetation biomass and

chlorophyll content rise, reaching

their peak when vegetation is at its

most lush and dense.

Lower Normalized Difference Vegetation Index (NDVI) values occur at the
beginning of the growth season – April and during periods of reduced
vegetation activity in September - a decline in NDVI values may exhibit also
reduced chlorophyll content or structural damage, affecting its reflectance
properties.

April 2016 June 2016 September 2016

April 2016 June 2016

September 2016



3.2 GNDVI analysis

Create the GNDVI. Use the resulted subsets. Navigate to the Main menu

– Raster - Band Maths and edit formula as following:

GNDVI = (NIR - Green) / (NIR + Green)

Click on RUN. Then, firstly open the output GNDVI images side by side

for all processed years – Window – Tile Horizontally. In Colour

Manipulation select Colour ramp derived from meris pressure.
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April 2016 June 2016 September 2016

April 2016 June 2016

September 2016

GNDVI values typically range from -1
to 1, with higher values indicating
healthier and more dense vegetation.
Values close to 1 indicate strong
vegetation presence, with dense and
healthy vegetation exhibiting the
highest values. Values close to 0
suggest sparse vegetation or non-
vegetated areas. Negative values may
occur in features such as water bodies
or shadows.



3.3 GRVI analysis

Create the GRVI. Use the resulted subsets. Navigate to the Main menu –

Raster - Band Maths and edit formula as following:

GRVI = (Green - Red) / (Green + Red)

Click on RUN. Then, firstly open the output GRVI images side by side for

all processed years – Window – Tile Horizontally. In Colour

Manipulation select Colour ramp derived from meris pressure.
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April 2016 June 2016

September 2016

GRVI index can differentiate between
green vegetation (index above 0),
water and snow (index around 0), and
soils (index below 0). Additionally,
unlike the NDVI, the GRVI is sensitive
to changes in leaf color, making it
effective for detecting shifts in
vegetation phenology.



4. Comparison of UAV data with Sentinel-2

In QGIS open the sample data for the smaller area of interest within the

locality of Šarišské Bohdanovce. Compare high spatial resolution of UAV

data compared to Sentinel-2 multispectral data.

UAV data offer high spatial resolution and flexibility, making them

suitable for detailed and targeted assessments of small areas. UAVs have

revolutionized, e.g. precise agriculture by providing farmers and

agronomists with timely, accurate, and actionable information for

optimizing crop production, resource management, and decision-making

processes. With their ability to collect high-resolution spatial data

efficiently and cost-effectively, UAVs are increasingly becoming

indispensable tools in modern agriculture.

On the other hand, Sentinel-2 satellite data provide consistent and

systematic coverage over larger regions, offering valuable insights into

broader landscape dynamics and long-term trends. The choice between

UAV and Sentinel-2 data depends on the specific requirements of the

application, considering factors such as spatial scale, temporal frequency,

cost, and accessibility.

For more information, see the lecture: 6. Precision agriculture mapping

using multispectral data
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UAV September 2016 Sentinel-2 September 2016

UAV September 2016 - detail

THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_06.pdf
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EXERCISE 7 – TUTORIAL

Spatio-temporal mapping of deforestat ion using

Sentinel-2 data using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Learn the basic steps to calculate the deforestation area based on
S2 images

 Download images of the same area of interest over a period of 4
years

 Perform preprocessing for the 4 images using SNAP software

1 | Exercise outline

1



Mapping deforestation using Sentinel-2 data

While various regions globally are undergoing deforestation, the reasons

driving this phenomenon vary among countries. Data from Global Forest

Watch's Dashboards reveals that, e.g. since 2001, Cambodia has seen a

reduction of approximately 24 percent in its tree cover—an alarming

percentage compared to more extensive, forested countries like Brazil and

Indonesia. Protected Planet reports that around 26% of Cambodia's land is

designated as protected areas for ecological or cultural conservation.

However, GFW data from 2001 to 2018 indicates a loss of 557,000

hectares of tree cover in these areas, comprising 11.7% of Cambodia's

total protected area. Many protected areas notably lost its protected

status due to extensive deforestation for rubber and cashew plantations.

This widespread forest loss contributes to increased flooding and erosion,

impacting water storage, fishing, and agriculture during droughts.

Presently, the majority of countries regularly conduct forest inventory or

remote sensing (RS) surveys every few years to observe alterations and

assess the quality of forest cover. Over the last decade, the Sentinel-1 and

Sentinel-2 satellite imagery from the European Space Agency's Copernicus

program has offered substantial potential for examining forest stands. This

technology can efficiently track changes, even in expansive forest areas,

with a high temporal and spatial resolution.

2 | Background

The presence of forests is crucial for

preserving ecological balance, combating

climate change, and ensuring a sustainable

future for both the Earth and its inhabitants.

Despite serving numerous essential

functions, these ecosystems have faced

significant threats to their condition, and

overall quality in recent decades.
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2.1 Study area and data used

For this exercise, we will use three Sentinel-2 images of the same area in

Stung Treng province, Cambodia, using the Tile Number *48PWV*

downloaded for years 2018, 2020, 2022 and 2023 from the Dataspace

Copernicus Open Access Hub [@https://dataspace.copernicus.eu/].

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 4 downloaded products

(unzipped) by double click on the metadata „MTD_MSIL2A.xml“ inside

the folder. The opened products will appear in Product Explorer window.

S2A_MSIL1C_20181102T031901_N0206_R118_T48PWV_20181105T173148.SAFE

S2A_MSIL1C_20200225T031711_N0209_R118_T48PWV_20200225T061710.SAFE

S2B_MSIL2A_20220120T032039_N0301_R118_T48PWV_20220120T070202.SAFE

S2B_MSIL2A_20230224T031729_N0509_R118_T48PWV_20230224T064733.SAFE
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Display all products side by side using e.g. Atmospheric penetration band

combination: Right click on the product – Open RGB Image Window –

select Sentinel 2 MSI Atmospheric penetration. Repeat this step also for

other three products.

The Atmospheric Penetration band combination (SWIR 2, SWIR 1, NIR)

shows results similar to traditional false-color infrared color composition

but with exceptional clarity. This method excludes visible bands,

effectively penetrating atmospheric particles, smoke, and haze, thereby

minimizing their impact on the image.
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Then, tile windows horizontally. By opening and displaying all 4 images at

once, we can take a first visual interpretation of deforestation in the

years 2018, 2020, 2022 and 2023 - from the left.

In Navigation tab – Synchronise views across multiple image windows –

Zoom into the eastern part of the image to explore deforestation.

2.3 Pre-processing

Firstly, it is advisable to reproject subsets to the system that corresponds

to the area of interest (Cambodia) - WGS 84, UTM zone 48 North. Go to

Raster – Geometric - Reprojection and reproject them to the system

WGS 84, UTM zone 48N. Writing target product may take some time. At

the end, 4 new reprojected products will be in the Product Explorer.
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2.3.2 Create Processing Graph

Then, we need apply the same pre-processing steps for all our scenes.

However, processing the data step by step and product by product could

be time-consuming and impractical. Fortunately, the Batch Processing

tool in SNAP allows us to apply all the steps to both images

simultaneously, saving both time and disk space since only the final

product is physically stored.

To use the tool, the initial step is to define the process we intend to apply

along with all its corresponding steps. This can be accomplished by

utilizing the GraphBuilder tool. Therefore, let's build our graph by

navigating to Tools → GraphBuilder.

Through the GraphBuilder function, we build a processing graph,

outlining the specific order of processing steps:

At the beginning, the graph has only two operators: Read (to read the

input) and Write (to write the output). To add the new operator right-

click the white space between the existing operators and select the

desired operators:

• Subset – export only bands that we will need for further analysis to

calculate NDVI – select only B4 and B8

• Band Maths – to calculate NDVI using slected bands B4 and B8

• Band Merge – to combine the resulting bands into the resulting file

For the moment, do not change anything in the parameter tabs and save

the graph (File – Save Graph) as „Graph_Deforestation.xml to your

working folder. After you have saved it, close the GraphBuilder window.
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2.3.3 Batch Processing

Open the Batch Processing tool (Tools → Batch Processing).

We will add all opened products by clicking Add Opened on the upper

right (second icon from the top). Then, we delete original = not

projected products by sleecting them and clicking Delete (third icon from

the top left only reprojected products). Then, when we have only 4

reprojected products, we click File - Load Graph at the top of the

window and navigate to our saved graph „Graph_Deforestation“ and

open it. We see that new tabs have appeared at the top of window

corresponding to our operators with the exception of Read; this is correct

as these parameters will be set in the I/O Parameters tab.

In the next step it is advisable to create Subset of these products for

faster processing:

• Source bands – select only bands that we will need to calculate NDVI

- B4 and B8

• Geographic Coordinates – create the subset of the area also by

clicking on zoom into the area of image (red rectangle) and draw

smaller (yellow) polygon inside it that includes only eastern part of the

images where we observed deforestation

• Reference band – select Reference band according which all the

Source Bands will be resampled



8

In BandMath, we enter the formula for NDVI calculation. The NDVI is

calculated as a normalized difference of visible infrared (B8) and visible

red (B4) bands, using the following equation (Rouse et al. 1974):

(B8-B4)/(B8+B4)



9

Then, in BandMerge tab we can combine the resulting bands into the

resulting file and set the directory for the output file in Write tab. The

common processing can be monitored. Writing target product may take

some time.



3. Image analysis

Open the output NDVI images side by side for all processed years –

Window – Tile Horizontally. In Colour Manipulation select Colour ramp

derived from meris pressure.

NDVI image - have values from ˂ -1, 1 ˃, where forested areas are

displayed in values higher than 0. The peaks of the histogram point to 2

extremes - forested and logged area.

For more information, see the lecture: 7. Spatio-temporal mapping of

deforestation using multispectral data
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THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_07.pdf


EXERCISE 8 – TUTORIAL

Mapping wild fires and burn sever ity using Sentinel-2

data, using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Detect wildfires on Sentinel-2 image

 Export subset as image to perform another analysis in QGIS 

 Map burned areas and quantify burn severity using Normalised
Burn Ratio index

 Develop a graph for automated processing using Batch processing

1

1 | Exercise outline



2 | Background

The wildfires around the important riverside port of Rosario, essential for

transporting Argentina's extensive grain harvest, have raised concerns

among local residents and activists.

Fires in the grasslands close to a vital South American river delta present

serious threats to both nearby wetland ecosystems and human well-

being, caution environmental experts. The wildfires around the important

riverside port of Rosario, essential for transporting Argentina's extensive

grain harvest, have raised concerns among local residents and activists.

The Parana River, South America's second-longest river after the

Amazon, experienced its lowest water levels since 1944 in 2021 as

reported by official data. This decline is attributed to multiple cycles of

drought and reduced rainfall in upstream Brazil. In August 2022, the

water level remained exceptionally low. The wildfires, many intentionally

set by farmers preparing the land for new crops, generated a thick haze

that reached Buenos Aires, located approximately 190 miles (300 km)

south of Rosario. Residents were displeased with the presence of soot in

the air, leading popular weather apps to issue forecasts simply describing

the conditions as "smoke."

2

Fires in the grasslands

close to a vital South

American river delta

present serious threats

to both nearby wetland

ecosystems and human

well-being, caution

environmental experts.

Wildfires burning in the wetlands of the Paraná River Delta, Argentina, 
19 August, 2022



2.1 Study area and data used

For this exercise, we will use two Sentinel-2 images of the same area in

Paraná River Delta, Argentina, using the Tile Number *20HQJ*

downloaded for two days of summer 2022 (before and after the wildfires)

from the Dataspace Copernicus Open Access Hub

[@https://dataspace.copernicus.eu/].

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 2 downloaded products

(unzipped) by double click on the metadata „MTD_MSIL2A.xml“ inside

the folder. The opened products will appear in Product Explorer window.

S2A_MSIL2A_20220730T135711_N0400_R067_T20HQJ_20220730T210856.SAFE.zip

S2A_MSIL2A_20220819T135721_N0400_R067_T20HQJ_20220819T211159.SAFE.zip

A: Detecting wildfires on Sentinel-2 image

1. Select the first product in the Product Explorer window.

2. Right click on the product.

3. Open RGB Image Window.

4. In the pop-up window select ‘Sentinel 2 MSI Natural colors (Red: B4;

Green: B3; Blue: B2)’.

5. Repeat the process for the second product.

6. Tile two opened RGB Windows, e.g. horizontally

7. In the Navigation window, zoom in to the wildfire region and

syhnchronise views to see the same area before and after wildfires
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Fire + cloud plume map

Do the same process for obtaining the color composition in false colors:

1. Select the first product in the Product Explorer window.

2. Right click on the product.

3. Open RGB Image Window.

4. In the pop-up window select ‘Sentinel 2 MSI Atmospheric penetration

(Red: B12; Green: B11; Blue: B8A)’.

5. Apply color manipulation (stretching) for RGB

6. Repeat the process for the second product.

7. Tile opened RGB Windows, e.g. evenly

8. If necessary, in the Navigation window, zoom in again to the wildfire

region and syhnchronise views to see area before and after wildfires

Now let’s detect the smoke plume:

1. Keep only the Sentinel 2 MSI Atmospheric penetration composition

with visible smoke plume from 19 August open

2. Go to Mask Manager, and scroll down to the Maths masks

3. Select: “scl_cloud_medium_prob“ and “scl_cloud_high_proba“

4. To visualize the masked areas better, lower the transparency(e.g. 0.1)
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Let’s export this View as an image and safe as a GeoTIFF:

Because of multiple S2 spatial sizes, we first have to resample the data.

Resample to highest spatial resolution: 10 m (e.g. B2).

Raster->Geometric->Resampling:

• Keep I/O names

• In Resampling Parameters, select B2 (10 m)

5



Let’s create a subset based on the current view

• Display the image. Note that now many more color options are

available. Select MSI Atmospheric penetration

• Make a zoom and add the cloud masks again

• Right-mouse button -> Spatial Subset from View – in the Band Subset

you can select all or only few bands to be exported
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Let’s reproject the image in Latitude & Longitude coordinates

• Raster->Geometric Operations->Reprojection

• Select the default: Geographic Lat/lon (WGS 84)

• Run (writing might take some time)

Now we can export View as GeoTiff

• Right mouse button: Export View as Image

• Select: Full scene, Full resolution, GeoTIFF
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Now we open the output image in QGIS

• We can overlay it to e.g. Google Satellite or Bing aerial image:

• Web->OpenLayers plugin->Google Maps->Google Satellite

• Move the Subset above the satellite

• Play with Transparency: Properties->Transparency (e.g. 80%)
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B: Burned area mapping with Sentinel-2

How to quantify the impact of the Paraná wildfire?

Let’s have look to the before & after images:

• Open RGB Image Window:

• Select: MSI Atmospheric penetration

• Window-> Tile horizontally, zoom in

Let’s create a cloud mask:

• Go to Mask Manager, and scroll down to the Maths masks

• Select: cloud medium & cloud high probability & Thin cirrus

• To visualize them better, lower the transparency (e.g. 0.1)

Now we make a cloud band based on the selected mask

• Band math expression
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We make a cloud band based on the selected mask

• Navigate to Raster - Band Maths

• Name the new mask: clouds

Adding the cloud mask as a band

• On the image, right click-> Band Maths

• Make sure to deactivate “Virtual”. We want to store the data!

• Go to “Edit Expression”

• Select Clouds

Repeat for the second image
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Vizualize all products

• Windows: Tile evenly

• Navigation: zoom all

Tools – Graph Builder

• Add->Raster->Geometric->Resample

• Add->Raster->Geometric->Subset

• Add->Raster->BandMaths

• Add->Raster->BandMerge

• Save your created graph
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Tools – Batch processing

This allows to process both images at the same time.

- Click on Add opened

- Load your graph

- Make sure to refresh

12



Resample

• Select a reference band: B2 at 10 m.

• Resampling method: Bilinear

Subset

• Select bands: B3, B8, B12, Cloud_mask

• Select Geographic coordination

• Click on A, zoom in to the area of interest

• Select a yellow box within the red square
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Band Math

• Go to “Edit Expression”

• NBR: Normalized Burn Ratio:

(B8-B12)/(B8+B12)

Band merge

• Keep the source bands: NBR, B3, B8, B12, cloud_mask
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Running and visualizing the NBR band

Try a color table:

• Colour manipulation: Open color table, choose a color gradient, e.g.
„derived from meris_cloud“
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You can also set the position of sliders and color them for better
visualization or change ranges of values in the Table tab.

NBR ranges between -1 and 1. A high NBR value indicates healthy
vegetation. A low value indicates bare ground and recently burnt
areas. Non-burnt areas usually have values close to zero.

Burn severity - dNBR

The difference between the pre-fire and post-fire NBR obtained from the
images is used to calculate the delta NBR (dNBR or ∆NBR), which then can
be used to estimate the burn severity. A higher value of dNBR indicates
more severe damage, while areas with negative dNBR values may indicate
regrowth following a fire. The formula used to calculate dNBR is illustrated

below:

dNBR or ∆NBR = PrefireNBR – PostfireNBR

Go to Raster – Band Maths and Edit Expression

16
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Set the position of sliders and color them for better visualization or change
ranges of values in the Table tab.

NBR ranges between -1 and 1. A high NBR value indicates healthy
vegetation. A low value indicates bare ground and recently burnt
areas. Non-burnt areas usually have values close to zero.

dNBR values can vary from case to case, and so, if possible, interpretation
in specific instances should also be carried out through field assessment;

in order to obtain the best results. However, the United States Geological
Survey (USGS) proposed a classification table to interpret the burn
severity, which can be seen below in the table.
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Comparison: Severity map, NDVI and false color composition

To compare different views of the same area and explore it more in detail,

create also NDVI and false color composition. You can observe, that areas
with high NDVI values correspond to the barren areas affected by
wildfires. False color composition also depicts areas affected by fire – these
areas are shown in dark pixels. False color composite B8-B4-B3 of the
Sentinel 2 image (during fire), with superimposed ongoing wildfire sites,

note that the smoke direction is corresponding to the wind direction.

For more information, see the lecture: 8. Mapping wildfires and burn
severity using multispectral data
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THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_08.pdf


EXERCISE 9 – TUTORIAL

Air quality monitoring using Sentinel-5 data –

pract icals, using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Define suitable search criteria (time range, area, satellite, satellite
product, visualization type) and compare images from different

sensors in EO Browser for a case study in air pollution

 Explore impact of Covid-19 on different cities in Europe

 Interpret Sentinel-5P NO2 maps in SNAP

 Context information with Sentinel-2

 Monitor volcanic emissions with Sentinel-5P

1

1 | Exercise outline



2 | Background

Nitrogen dioxide (NO2) is a common air pollutant that plays a big role in

the formation of smog and acid precipitation. Over 90% of the overall

nitrogen oxide emissions are released into the air during the combustion

of diverse fuel types.

There has been a notable increase in the amount of satellite data

specifically related to air pollution. In particular, satellite instruments for

observing the lower troposphere have significantly improved. Space

radiometers, like MODIS, GOES, AVHRR and TOMS have proven very

useful in measuring aerosols and air pollutants across large areas. The

latest generation spectrometers, such as TROPOMI, are capable of

detecting NO2 and other pollutants in urban areas.

TROPOMI (Tropospheric Monitoring Instrument) is part of the payload on

the ESA Sentinel-5 Precursor (Sentinel-5P) satellite, designed for the

monitoring of Earth's atmosphere. It is an imaging spectrometer utilizing

passive sun backscatter technology, allowing for the capture of imagery

across eight bands, ranging from ultraviolet (UV) and visible to near-

infrared (NIR) and shortwave infrared (SWIR) spectral domains. This

instrument boasts a spatial resolution of 7 × 3.5 km² in both along-track

and across-track dimensions. S5–P promptly delivers data on various

trace gases, including O3, SO2, NO2, CO, and CH4).

Sentinel-5P played a crucial role also in monitoring changes in air quality

during the COVID-19 pandemic. By capturing data on NO2 levels from

space, Sentinel-5P helped scientists and authorities assess the impact of

lockdown measures on air pollution. The satellite data provided valuable

insights into how NO2 concentrations fluctuated in response to changes

in human activities and mobility restrictions.
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Images that meet
the search criteria

Visualization of the
selected image

2.1 NO2 mapping with EO Browser

1. Login (register for free) to have full access to all the tools in EO

Browser: https://apps.sentinel-hub.com/eo-browser

2. Navigate to the area of northern Italy

3. Create an area of interest using polygon – draw e.g. rectangular

shape

4. Select Sentinel-5P sensor and NO2 (Nitrogen dioxide)

5. Define Time range: 2020-03-11 to 2020-04-11

6. Click Search.

7. Search for the first image from 2020-03-11 and visualise it

Data source
selection

Selection of time
range of data
acquisition

Log in

Create area
of interest

3

https://apps.sentinel-hub.com/eo-browser


8. Visualize the legend too

9. Add to Compare the Sentinel-5P NO2 image from 2020-03-11 by

using Add to Compare function.

10. Repeat the process with the second image - last search result (2020-

04-11), visualize it and Add it to Compare

11. Now go back to Search tab and search for suitable cloud-free

Sentinel-2 images for the same area of interest (Note: In this case it

may be necessary to use two Sentinel-2 images from two different

days with overlap – e.g. from 2020-04-23 and 2020-10-28) – Add

them to Compare)

12. Open the Compare tab and explore images – NO2 emissions before

and during the restrictions against Covid-19 and Sentinel-2 true color

compositions

Add images to 
Compare

Visualize and 
read the legend
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March 2020 - Start
of Covid-19 restrictions

April 2020 - One month after
implementation restrictions

against Covid-19

What you are seeing are the NO2 concentrations over Europe as mapped

by the satellite Sentinel-5P on March (begging of Covid-19 restrictions)

and April (after 1 month with Covid-19 restrictions). NO2 concentrations

in clean air are close to 0 (shades of blue) and they only rise when an

emission source is present. For example, large amounts of NO2 are

released by the burning of fossil fuels so industry and vehicle traffic

contribute to high levels of NO2 (shades of orange, red). As you can see

in the image, high concentrations can be found mostly in urban areas,

e.g. Milan, Treviso, Brescia, Verona. Milan is usually ranked as the worst

Italian city in terms of NO2 pollution that often exceeds the mean annual

concentration European limit value.

As we can see, one month after the restrictions hold against Covid-19

made an impact visible on concentrations of NO2. The satellite data

provided valuable insights into how NO2 concentrations fluctuated in

response to changes in human activities and mobility restrictions.

Adjust split positions
to explore differences
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Now let’s explore also data from Sentinel-2 for better understanding of

the scene. The Sentinel-5P image covers a larger area than the Sentinel-

2 image. Therefore we use two Sentinel-2 images, which loverlap only a

bit with each other, and which allow us to cover a larger part of Italy

when we put them together. In this way we have more areas of

comparison between the two satellites.
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Note: Observe also that many pixels in the image are empty. That is

because these pixels couldn’t be retrieved for example due to clouds.

Since the pixels are also quite large (one S-5P pixel covers an area of

7km*7km) it gets difficult to interpret this image. Let’s use data from

Sentinel-2 for better understanding of the scene.

March 2020 - Start
of Covid-19 restrictions

Adjust split positions
to explore differences
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2.2 Monitoring volcanic emissions with Sentinel-5P

Kilauea volcano, 
Hawaii

Ninety-nine percent of the gas molecules released during a volcanic

eruption consist of water vapor (H2O), carbon dioxide (CO2), and

sulfur dioxide (SO2). The remaining one percent comprises small

quantities of hydrogen sulfide, carbon monoxide, hydrogen chloride,

hydrogen fluoride, and other minor gas species, as noted by the US

Geological Survey (USGS).

Volcanic eruptions are potent agents of

change, impacting nearby landscapes and

water. They can temporarily alter the

Earth's climate by releasing sulfuric acid

droplets into the stratosphere. Proximity

to volcanoes may necessitate permanent

evacuations, and even distant areas may

experience damage to cities, crops, etc.
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Lava flows in the Halema'uma'u crater among several active vent sources

as the Kilauea volcano erupts in Hawaii on June 7, 2023.

February 2019 February 2020 February 2021
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2.3 NO2 mapping in SNAP

Let´s explore NO2 concentrations over Europe in SNAP:

We can open a Sentinel-5P image navigating to File – Open Product –

open the product with the .nc extension:

Select one of the following readers for the selected sile to open it.

Double click on selected layer that we want to visualise
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Raster – Geometric – Reprojection

Select Custom CRS – WGS84:

Let´s open new reprojected product
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Raster – Geometric – Reprojection

Select Custom CRS – WGS84:

Let´s open new reprojected product. View the final NO2 raster in QGIS.

Compare it with e.g. land cover mask.
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2.4 NO2 mapping with Copernicus Sentinel-5P Mapping Portal

Let´s explore NO2 concentrations over Europe using Copernicus Sentinel-

5P Mapping Portal:

Try to identify cities, regions with high concentrations of NO2 and ship

routes according NO2 concentrations on the map.

Let´s explore NO2 concentrations over China using Copernicus Sentinel-

5P Mapping Portal:

For more information, see the lecture: 9. Air quality monitoring using

Sentinel-5 data

London

ship route

ship route

Antwerp

Paris

northern Italy

RomeMadrid

Netherlands, Belgium

February 2019 February 2020 February 2021
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THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_09.pdf


EXERCISE 10 – TUTORIAL

Land surface temperature mapping using Sentinel-3

data using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 learn about the phenomenon Urban Heat Island

 use Sentinel-3 LST product to analyse and classify surface
temperature

 use land cover / land use band for extraction of land temperature

 extract the mean temperature by Pin placing tool and SNAP
Statistics tool

 visualize the resulting Urban Heat Island map clipped on an
interesting area

1 | Exercise outline

1



Urban heat islands are regions within cities that encounter higher

temperatures compared to their surrounding areas. The presence of

structures like buildings and roads, along with limited greenery, causes

urbanized zones to absorb and release solar heat more efficiently than

natural landscapes. This concentration of structures in urban areas leads

to the formation of "islands" with higher temperatures, where daytime

temperatures can be 1-7°F higher and nighttime temperatures

approximately 2-5°F higher than those in the adjacent areas.

Urban areas, marked by high population and construction density, face

challenges related to waste heat and Urban Heat Islands (UHIs). As cities

expand vertically with skyscrapers, trapped heat from construction

accumulates within UHIs. During nighttime, UHIs retain higher

temperatures due to obstruction of upward heat movement by buildings

and infrastructure, creating a warmer environment.

Furthermore, UHIs exhibit worse air and water quality compared to rural

areas. The dense concentration of pollutants, originating from vehicles,

industry, and human activities, results in lower air quality.

2 | Background

2



2.1 Study area and data used

In this exercise, we will analyse Sentinel-3B image acquired during June

2023 and downloaded from the Dataspace Copernicus Open Access Hub

[@https://dataspace.copernicus.eu/].

Navigate to the area of Slovak republic, create an area of interest by

clicking on the icon in the upper right corner of the map and draw a

rectangle as indicated below.

In the search menu on the left specify the following parameters and

press the search button:

Data source: Sentinel-3 – SLSTR – Level-2 LST

Sensing period: From 2023/06/20 to 2023/06/20

In our case, the search returns 16 results (day and night acquisitions).

Search for those that cover the entire area of the Slovakia and download

them (if needed).
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Download the day product by clicking on the arrow icon. Note the

different sensing times of the images:

S3B_SL_2_LST____20230620T090758_20230620T091058_20230621T0

02041_0179_080_378_2160_PS2_O_NT_004.SEN3 (day acquisiton)

Once downloaded, move it to your folder for this exercise and unzip it.

2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and navigate to the folder where

you saved your downloaded products and open the day-time Sentinel-3

product from 2023-06-20:

S3B_SL_2_LST____20230620T090758_20230620T091058_20230621T0

02041_0179_080_378_2160_PS2_O_NT_004.SEN3

Open the folder and select the file xfdumanifest.xml. Then, click OK.

In the Product Explorer, expand the product by clicking in the left arrow.

Expand now the Bands folder and double click on the band LST to

visualize it.
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2.3. Subset

The initial phase of the methodology involves reducing the original size

and number of bands in the image. To accomplish this, choose the

Sentinel-3 SLSTR product in the Product Explorer, then proceed to Raster

-> Subset. Within the Spatial Subset tab, select Geo Coordinates and

input the specified values:

North latitude bound: 51.00

West longitude bound: 12.00

South latitude bound: 42.00

East longitude bound: 26.00

In the Band Subset tab, opt for the bands NDVI, biome, fraction, LST,

x_in, y_in, latitude_in, and longitude_in. In the Tie-Point Grid Subset

tab, choose only the bands x_tx, y_tx, latitude_tx, and longitude_tx.

Then, click OK (responding with No to the pop-up flag dataset window).

Upon completion, the subset product will be visible in the Product

Explorer. It is essential to save it by right-clicking on it and selecting

Save Product. Confirm the saving process by clicking YES in the ensuing

pop-up window.
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Upon completion, the subset product will be visible in the Product

Explorer. It is essential to save it by right-clicking on it and selecting

Save Product. Confirm the saving process by clicking YES in the ensuing

pop-up window.

2.4 Reprojection

Proceed to reproject the Sentinel-3 SLSTR product using an appropriate

map projection. Navigate to Raster -> Geometric -> Reprojection.

In the I/O Parameters tab, ensure that you choose the subset product as

the input. Modify the output name to e.g.

"S3B_LST_20230620_day_reprojected" and set/confirm that the output

directory.

Within the Reprojection Parameters tab, access the Projection drop-down

menu, and opt for UTM/WGS 84 (Automatic). Subsequently, click on Run.
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Within the Product Explorer, expand the reprojected product by selecting

the left arrow. Expand the Bands folder, and double-click on the LST band

to view it.

Access the Colour Manipulation tab, choose Basic as the Editor, and click

on the e.g. „derived from spectrum_large“ color ramp

2.5 Clip by mask

Now let´s focus on the smaller area of interest, e.g. territory of the

Slovak Republic. Choose the last Sentinel-3 reprojected product in the

Product Explorer, then proceed to File – Import – Vector data – ESRI

shapefile and open „SR_boundaries.shp“ file that you have in the folder

for this exercise. Once imported, this layer should appear within the

product Vector data and also on the visualized LST image.
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Now navigate to Raster – Masks – Land/Sea Mask. In the I/O Parameters

tab you can rename the output target product to e.g.

"S3B_LST_20230620_day_reprojected_msk" and set the output

directory. In the Processing Parameters select the option „Use Vector as

Mask“ and „SR_boundaries“ layer according to which the product will be

clipped.

The resulted clipped product of the area of the Slovak Republic can be

reprojected to lacal coordinate system using an appropriate map

projection. Navigate to Raster -> Geometric -> Reprojection.
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• In the I/O Parameters tab, ensure that you choose the last clipped

product as the input. Modify the output name to e.g.

"S3B_LST_20230620_day_reprojected_msk_Krovak" and set/confirm

that the output directory.

• Within the Reprojection Parameters, access the Projection drop-down

menu, and opt for Custom CRS - Krovak. Subsequently, click on Run.

• Within the Product Explorer, expand the final reprojected product by

selecting the left arrow. Expand the Bands folder, and double-click on

the LST band to view it. Access the Colour Manipulation tab, and

choose e.g. „derived from spectrum_large“ color ramp
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Explore the temperatures (in Kelvins). Click on the Pixel info tab and

move the mouse over the images to analyse pixel values.

2.6 Add Land Cover Band

After comparing the temperature values (in Kelvin) during the day and

night acquisitions, proceed to close the day product. In order to better

identify the influence of urbanised areas on temperature, subtract the

average temperature of non-urban areas near Košice.

To facilitate this, create smaller subset of day image – zoom into the

vicinity of the Košice city, estern Slovakia – right click on the view –

Spatial Subset from View... OK.

Then, open the LST layer from Bands of newly created subset and add a

land cover band to distinguish various land cover and land use types. To

do this, right-click on the day product, choose "Add Land Cover Band,"

navigate to CCILandCover-2015 in the menu, and click OK.
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2.7 Mean temperature

After adding the land cover band, the subsequent action involves

calculating the average temperature in the vicinity of Košice city by

utilizing specific pixel values pinpointed with the Pin tool in SNAP. The

ideal quantity is around 10 control points. Using these control points, it

becomes feasible to calculate an average temperature value.

After creating the pins in the image, we can calculate the average value

for the pixels identified by these pins using the Statistics tool in SNAP.
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Close the land cover visualization and navigate to the Analysis ->

Statistics. Choose the option „Use ROI Mask(s)" and select "pins." Lastly,

click the refresh button.

From the panel on the right side, we can obtain the mean temperature

value (304.2688) for day image by referencing the pins recently inserted

into our image.

We can proceed to utilize the Band Math operator to subtract this value

from the LST measurements. Right-click on the LST_20180802_night

product, choose Band Math, modify the name to UHI_night, uncheck

Virtual, and click the Edit Expression button. Copy and paste the

provided expression, then click OK:
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Close all previous visualizations except for the recently generated

UHI_day_20230620band. Navigate to the Colour Manipulation tab,

choose Basic as the editor, and select the palette. Then, click on the tab

From Data to see the range of the final night UHI. Adjust the Min and

Max values to ranges from 0 to the last value of the dataset (in this case

12.0).
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2.8 Data export to QGIS

Once the result is ready, we will export it as GeoTIFF and open it in

QGIS. For that, data must be again reprojected to Geographic Lat/Lon.

Then, go to File -> Export -> GeoTIFF. Click on the Subset tab, and in

the Band Subset menu select only the band UHI_day_20230620. Save

the file with the name UHI_night_20230620.tif in the following path and

click Export Product:

Data import to QGIS

Once the images are processed in SNAP, we will visualize the results in

QGIS. Minimize SNAP and open QGIS.

Import the subset_UHI_day_202306 into the panel Layers

Edit image parameters of subset_UHI_night_202306 – Navigate to

Properties of this image and change the color palette. Set the Min/Max

values for the night UHI similar like in the SNAP (0-12).
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Now navigate to Web – OpenLayers plugin – Bing maps and add e.g.

Bing aerial with labels. Place the layer UHI_day_20230620 above the

layer of Bing map. Set transparency to the UHI_day_20230620 layer

(Properties – Transparency).

Finally, explore the Urban Heat Island in the vicinity of Košice city and

land use/cover that affects it.

For more information, see the lecture: 10. Land surface temperature

mapping/urban heat island mapping using ESA EO data
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THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_10.pdf


EXERCISE 11 – TUTORIAL

Generat ing high resolut ion binary and fract ional snow

maps from Sentinel-2 data using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Explore how data from Sentinel-2 multispectral data are used to
detect and measure snow extent

 Larn how to generate and interpret high resolution binary and
fractional snow cover products

 Demonstrate real-world examples and applications of these
techniques in cryospheric research

1 | Exercise outline
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Mapping snow and ice using Sentinel-2 data

The routine creation of hemispheric or global snow cover extent data

typically relies on medium-resolution optical satellite data, such as

Sentinel-3 SLSTR/OLCI, Terra/Aqua MODIS, or NPP VIIRS. To evaluate the

accuracy of these products, snow maps derived from high-resolution

optical satellite data, such as Sentinel-2 MSI or Landsat 8 OLI, can be

utilized.

In this task, you'll produce binary and fractional snow cover datasets

using a Sentinel-2 scene captured over the Alps on April 29, 2016. Two

approaches, both centered on the Normalized Difference Snow Index

(NDSI), will be tested.

Snow cover extent map

In this Copernicus Sentinel-2 image of 17 December 2015, we can see an example of

a snow cover extent map from Sentinel-2 tile T32TLR during the winter season.

Source: Contains modified Copernicus Sentinel data (2015)/processed by e-shape

2 | Background
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2.1 Study area and data used

For this exercise, we will use Senetinel-1 and Sentinel-2B images of the

Hight Tatras area in Slovakia, with its expanse of national parks with its

typical flora and rocky mountains covered, especially in winter season

with snow and ice. For the first part of the exercise, we will use the Tile

Number *34UDV* downloaded for 25 March 2022 from the Dataspace

Copernicus Open Access Hub [@https://dataspace.copernicus.eu/].

S2B_MSIL2A_20220325T094029_N0400_R036_T34UDV_20220325T132010.SAFE
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2.2 Part A: Generate high resolution binary and fractional snow maps

from Sentinel-2 data over the Alps

SNAP - Open and explore product

Open SNAP Desktop and import the Sentinel-2 data set Sentinel-2: File

Import Optical Sensors Sentinel-2 S2 MSI L2A. Navigate to the S2

directory in the input data directory and select the XML file. The opened

products will appear in Product Explorer window.

S2B_MSIL2A_20220325T094029_N0400_R036_T34UDV_20220325T132010.SAFE.zip

Get a first overview of the snow and cloud conditions on the 25 March

2022 over Tatra´s region using true- and false colour composite previews:

1. Select the product in the Product Explorer window.

2. Display product using e.g. True and False color composition: Right

click on the product - Open RGB Image Window.

3. In the pop-up window select ‘Sentinel 2 MSI Natural colors (Red: B4;

Green: B3; Blue: B2)’.

4. Then, choose another color composition, e.g. ‘Sentinel 2 MSI False-

color Infrared (Red: B8; Green: B4; Blue: B3)’.

5. In the Navigation window, zoom in to the snow region

6. Tile Windows, e.g. Horizontally

7. Get an impression on the overall snow conditions on 25 March 2022
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Get familiar also with the basic information associated to the Sentinel-2

data set:

Open the file structure of the Sentinel-2 scene by double left click on the

product (or click on the +). Click on the menu Metadata, double click on

Level-2A_User_Product and find the spectral information for the bands

needed for the snow mapping approaches (B3, B8, B11): band numbers,

resolution (pixel size).

Resample

Resample the bands to the pixel size of the VIS bands:

In the main SNAP menu, select Raster - Geometric - Resampling

In the I/O Parameters tab, the source product is set to our only product

in the SNAP, change the name of the target resampled product if needed

Do not save the output product - disable the box “Save as:” (if selected).

In the Processing Parameters tab, use e.g. B3 with 10 m resolution to

resample all the bands to 10 m as output spatial resolution.
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Create subset

Click on the resampled product in the Product Explorer, go to the main

SNAP menu and select Raster - Subset…:

Create a subset with the following settings:

Spatial subset:

Scene start X: 0,

Scene start Y: 2000,

Scene end X: 7000,

Scene end Y: 8000

Band subset: B3, B8, B11

And click OK

In the main SNAP menu, select Raster - Band Maths (unlock the box

“Virtual”)

From the created subsets, calculate the NDSI using the 1.6 µm and the

0.56 µm bands and save the output.

6



Normalized Difference Snow Index

Next, we will calculate Normalized Difference Snow Index (NDSI) in

SNAP.

The Sentinel-2 NDSI is a ratio of two bands: one in the VIR (Band 3) and

one in the SWIR (Band 11). Values above 0.42 are usually snow. The

Sentinel-2 NSDI can be used to differentiate between cloud and snow

cover as snow absorbs in the short-wave infrared light, but reflects the

visible light, whereas cloud is generally reflective in both wavelengths.

Most potential cloudy pixels have NDSI values in a range between -0.1

and +0.2.

To calculate NDSI, select the last subset product, navigate to the main

SNAP menu and select Raster - Band Maths (deselect the box “Virtual”).

Click on Edit Expression to calculate the NDSI using the equation below

and click OK:

ρ(VIS) – ρ(SWIR) / ρ(VIS) + ρ(SWIR)

ρ = Top of atmosphere reflectance

VIS = Visible band (0.56 µm)

SWIR = Short-Wave Infrared Band (1.6 µm)

Replace the bands in the equation with the corresponding bands for

Sentinel 2:

ρ(B3) – ρ(B11) / ρ(B3) + ρ(B11)

Open the output product in the Product Explorer by double click on the

new raster NDSI within Bands folder.

Go to Color Manipulation tab and go to Table – set the thresholds of

slider to three values – minimum value, up to 0.42 (usually pixels with

no snow), higher than 0.42 (usually snow pixels) and maximum value.
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Explore the image: values above 0.42 are usually snow pixels (shades of
grey for the lowest probability of snow and shades of white for the
highest probability of snow). The Sentinel-2 NSDI can be also used to
differentiate between cloud and snow cover as snow absorbs in the
short-wave infrared light, but reflects the visible light, whereas cloud is

generally reflective in both wavelengths.

Most potential cloudy pixels have NDSI values in a range between -0.1
and +0.2. Add 4 new sliders and change their colour to e.g. red to
highlight these values of potentially cloudy pixels.
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Binary snow classification (snow / no snow)

Applying thresholds on the NDSI and a Near Infrared band (NIR, e.g.
0.842 µm) it is possible to derive binary snow classification.

The method utilized in this task has been adjusted and made simpler
based on the approach employed in the Theia Snow collection (Gascoin et
al. 2019). We apply a cautious threshold to NDSI. Certain murky waters
may exhibit comparably high NDSI values, thus, we incorporate an extra
condition concerning red reflectance to prevent erroneous snow

identification in such regions. A pixel free from clouds is classified as
snow under these conditions:

(𝑁𝐷𝑆𝐼 < 𝑛1) 𝐴𝑁𝐷 (𝜌𝑟𝑒𝑑 < 𝑟1)

Where n1 and r1 are the selected thresholds, during the first pass they
are set conservatively high to avoid false detections. If the above
expression is not fulfilled, then the pixel is marked as “no snow”

Minimum value of NDSI for the pass 1 snow test - n1 0.4
Minimum value of the red band (B8) for the pass 1 snow test - r1 0.11

After subsititution with corresponding Sentinel-2 bands, the equation is:

Expression: if NDSI > 0.4 AND B8 > 0.11 then 1 else 0

Now, navigate to Main Menu: Raster – Band Maths
Unlock the band “Virtual”, 
Define output layer name: binary_snow_classification
and Edit Expression: if NDSI > 0.4 AND B8 > 0.11 then 1 else 0

Open the output product in the Product Explorer by double click on the

new raster „binary_snow_classification“ within Bands folder.

Go to Color Manipulation tab and go to Table – set the thresholds of

slider to three values – minimum value, up to 0.42 (usually pixels with

no snow), higher than 0.42 (usually snow pixels) and maximum value.
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We can observe that pixels have been divided into two cathegories: with
snow (white pixels) and without snow (black pixels)

Fractional snow cover
In the second part of the task, we will try to detect fractional snow cover
(FSC, 0 % - 100% snow) according to the approach of Salomonson and
Appel (2004, 2006), which was originally developed for MODIS data:

FSC = (–0.01 + 1.45 * NDSI)*100+100

Now, navigate again to Main Menu: Raster – Band Maths
Unlock the band “Virtual”, 
Define output layer name: fractional_snow_cover
and Edit Expression: (–0.01 + 1.45 * NDSI)*100+100
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In forested areas, this approach aims on detecting the viewable snow,
i.e. the snow on top of the forest canopy. Let´s check the results.

Open the output product in the Product Explorer by double click on the

new raster „fractional_snow_cover“ within Bands folder.

Go to Color Manipulation tab and set value range between 100 (snow free)

and 200 (100 % snow covered):

For more information, see the lecture: 11. Snow and ice cover mapping

using ESA Sentinel-1 and Sentinel-2 data
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THANK YOU FOR FOLLOWING THE EXERCISE!

https://uge-share.science.upjs.sk/webshared/ESA_ENEUM/Applications_ESA_sensors/Lectures/Lecture_11.pdf


EXERCISE 12 – TUTORIAL

Retrieval of digital elevation model (DEM) from

Sentinel-1/DEM generation with Sentine l-1,

comparison with LiDAR outputs, using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Learn how to retrieve Digital elevation model (DEM)

 Perform necessary data processing for making an interferogram

 Understand the information content in SAR interferometric images

 Compare Sentinel-1 derived DEM with LiDAR outputs

1 | Exercise outline
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Deformation Mapping and Change Detection using Sentinel-1 data

DEM generation with Sentinel-1 data offers a powerful method for deriving

accurate and detailed elevation information over large areas, especially in

regions with limited ground survey data or challenging terrain conditions.

DEM generation with Sentinel-1 data involves acquiring pairs of SAR

images, processing them into interferograms, unwrapping the

interferometric phase to obtain absolute phase values, removing the

topographic phase contribution, converting the corrected phase into

elevation values using appropriate algorithms, assessing the quality of the

generated DEM, refining it if necessary, validating the accuracy, and

utilizing the DEM for visualization and various applications such as terrain

analysis and environmental monitoring.

Sentinel-1 derived DEMs find applications in topographic mapping,

hydrological modeling for water flow and flood risk assessment,

environmental monitoring for changes like erosion and landslides, natural

resource management for agriculture and forestry, disaster management for

assessing terrain accessibility and planning evacuation routes, infrastructure

planning for designing roads and bridges, climate change studies for

analyzing impacts on coastal erosion and glacier retreat, and remote sensing

applications including orthorectification and 3D visualization.

2 | Background

Satellites constantly monitor

Earth from space, providing vital

data essential for rapid land

cover change assessment and

disaster management. The radar

on board the Copernicus

Sentinel-1 mission can detect

ground conditions and penetrate

clouds, functioning day and night.
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2.1 Study area and data used

For this exercise, we will use two Sentinel-1 SLC images of the same area

for High Tatras, Slovakia, downloaded from the Dataspace Copernicus

Open Access Hub [@https://dataspace.copernicus.eu/].

To ensure successful DEM generation, selecting image pairs with specific

properties is crucial. These include:

• A short temporal baseline, minimizing the time between acquisitions

to reduce temporal decorrelation risks, particularly over changing

surfaces like vegetation or water areas. Sentinel-1 radar (C-band) is

susceptible to decorrelation, especially over vegetation, so image pairs

with minimal vegetation cover are preferable.

• A suitable perpendicular baseline, ideally between 150 and 300

meters, to capture topographic variations effectively through parallax-like

effects. Smaller baselines may not produce pronounced topographic

effects, while larger ones can lead to decorrelation.

• Consideration of the primary mission focus of Sentinel-1 for

deformation retrieval rather than DEM generation, resulting in

predominantly short baselines below 30 meters. Finding image pairs with

short temporal and large perpendicular baselines can be challenging.

• Ensuring suitable atmospheric conditions, avoiding images acquired

during rainy periods or with high water vapor content in the atmosphere

to minimize phase delays and maintain measurement quality.
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2.2. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open 2 downloaded products

by double click on the zipped folders. The opened products will appear in

Product Explorer window.

S1A_IW_SLC__1SDV_20230721T162703_20230721T162731_049524_05F481_08D0.SAFE.zip

S1A_IW_SLC__1SDV_20230802T162703_20230802T162731_049699_05F9EC_E68C.SAFE.zip

To access the information within the product, double-click on it to reveal

the directories, which include:

• Metadata: containing parameters pertaining to orbit and data.

• Tie Point Grids: providing interpolation data for latitude/longitude,

incidence angle, etc.

• Quicklooks: presenting a visible image of the entire scene in radar

coordinates.

• Bands: consisting of complex values for each subswath "i" and "q",

along with intensity

Select intensity image for swath IW1 VV – double click on it to View it

Note: Each SAR image is flipped north—south it maintains the same

orientation as its acquisition (in this case, ascending track).

Check baseline information

As previously mentioned, the quality of DEM generation relies heavily on

the characteristics of the satellite images, particularly the spatial

arrangement of the satellites during acquisition, termed the

perpendicular baseline. A larger perpendicular baseline yields more

detailed interferograms, enhancing the representation of elevation

changes. For instance, a perpendicular baseline of 151 meters, as

illustrated in Figure 8, produces denser fringe patterns, facilitating better

terrain change description compared to baselines of 67 meters or 27

meters.

The time interval between the first and second images, known as the

temporal baseline, also significantly impacts interferogram quality.

Shorter temporal baselines, ideally around 6 or 12 days for Sentinel-1

data, minimize phase decorrelation issues, particularly over natural

surfaces. As illustrated in Figure 9, longer temporal baselines result in

poorer interferogram quality, particularly over areas with natural

surfaces, where reliable height information cannot be extracted. If such

areas dominate the interferogram, DEM extraction becomes unfeasible.

To examine the baseline details of your image pair, navigate to Radar >

Interferometric > InSAR Stack Overview.

4



Initially, select "Add Opened" to import the two Sentinel-1 products into

the list above, where their acquisition date, track, and orbit information

should appear.

Next, click on "Overview" to access their metadata.

In the lower list, you'll find details such as:

• the perpendicular baseline (Bperp) in meters,

• the temporal baseline (Btemp) in days,

• the modelled coherence ranging from 0 to 1,

• the height ambiguity indicating the height difference represented by

one color cycle in the interferogram,

• the mean Doppler centroid frequency difference.
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Figure: Effect of the perpendicular baseline on the interferogram (Braun 2021) 



2.3 Coregistration

To utilize the phase difference between the acquisitions, it is necessary to

initially construct a stack comprising both products. Image coregistration

makes use of image statistics to align both products at sub-pixel accuracy.

While orbit state vectors alone can suffice to coregister images, for precise

offset tracking, additional data from a digital elevation model (DEM) is

necessary to enhance coregistration accuracy.

Navigate to Main Menu – Radar – Coregistration – S1 TOPS Coregistration

–S1 TOPS Coregistration

In the Read tab, select the 20230721 SLC product and in the Read(2) tab

select the 20230802 SLC product

In TOPSAR-Split and TOPSAR-Split(2) tabs select Subswath: IW1

Polarizations:VV

In the Apply Orbit File and Apply Orbit File(2) tabs select leave default

parameters and uncheck „Do not fail if new orbit is not found“ option
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In the Back-Geocoding select SRTM 1Sec HGT (AutoDownload)

In the Write tab, select the directory to save your processing outputs

Note: SRTM data is accessible only within the latitudinal range of 60° North

to 54° South. If your area falls outside this coverage, alternative DEMs

with AutoDownload functionality can be utilized, or an external DEM stored

as a GeoTiff and projected in geographic coordinates/WGS84 can be

employed.
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Once coregistration is finalized, it is

recommended to visually inspect

the stack's quality. This can be

achieved through an RGB

representation of the reference and

secondary products, indicating if the

images are appropriately aligned:

Right-click on the output

coregistrated product – Open RGB

Image Window

Choose the reference for red and

green channels, and the secondary

image for the blue channel.Click OK.



Zoom into a region with contrasting surfaces, such as the boundary

between land and water. The RGB image should be clear and sharp,

without being overly influenced by one of the images (e.g., appearing

yellow for the reference or blue for the secondary image). The only

acceptable exceptions are changes in land cover or scattering mechanisms

which occurred in the time between the image acquisitions.

2.4 Forming a Raw Interferogram

The next phase of interferometry involves generating an interferogram

using the coregistered SLC images. To do this, follow these steps:

From the main menu bar, go to Radar – Interferometric - Products and

finally select Interferogram Formation.

In the I/O Parameters tab, choose the "Orb_Stack" product that was

generated during the coregistration process.

By default, the output target is set to the same directory and appends "ifg"

to the filename.

For standard processing, there's no need to modify the defaults in the

Processing Parameters tab.
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Raw Interferogram — Phase Image should appear int he View tab.

The interferogram is displayed in a rainbow color scale ranging from -

topography, atmosphere and potential surface deformation (considered

zero). The patterns, also called fringes appear in an interferogram as

cycles of arbitrary colors, with each cycle representing half the sensor’s

wavelength.

2.5 TOPS Debursting

The next stage in interferometry using Sentinel-1 TOPS mode (IWS) data

involves "debursting" or merging the bursts to remove the seamlines, a

step not required with Sentinel-1 or other stripmap SAR data.

To perform debursting, follow these steps:

From the main menu bar, navigate to Radar, then Sentinel-1 TOPS, and

finally S-1 TOPS deburst.

In the I/O Parameters tab, choose the "Orb_Stack_ifg" product generated

during the interferogram formation process. By default, the output

appends "deb" to the filename.

There is no need to make changes in the Processing Parameters tab.
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2.6 Goldstein Phase Filtering

There are two methods to minimize noise in the interferogram: filtering

and multi-looking. While our standard procedure involves applying filtering

initially, it's also possible to opt for multi-looking first.

To begin filtering:

Go to Radar, then Interferometric, then Filtering, and select Goldstein

Phase Filtering from the top main menu bar.

In the I/O Parameters tab, choose the "deb" product generated in the

previous step.

By default, the output name includes "flt."

There's no necessity to adjust the default settings in the Processing

Parameters tab for basic processing.

Create subset (optional)

In the earlier stages of processing, empty pixels along the interferogram's

perimeter may have been created, particularly in regions not overlapped

by both input images. To remove these sections, employ the Subset

function found under Raster. This approach will also decrease processing

time in subsequent stages, especially when the analysis is concentrated on

a specific area rather than the entire scene.
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Double-click on the output

raster in the Bands folder of

the new product to see the

result.



2.7 Phase Unwrapping

Unwrapping in SNAP follows three distinct steps:

1. Export of the wrapped phase (and definition of the parameters)

2. Unwrapping of the phase (performed outside SNAP by snaphu)

3. Import of the unwrapped phase back into SNAP

Export of the wrapped phase

Export your interferogram or your subset interferogram from Sentinel-1

Toolbox to SNAPHU:

From the top main menu bar, navigate to Radar > Interferometric >

Unwrapping > Snaphu Export:

In the Snaphu Export window:

In Read tab, select the product created in the previous step

In Snaphu Export tab, you also need to specify a target folder for exported

files. Create a new target folder for this step by entering a path and new

folder name (e.g. „snaphu_export). If the selection of the directory does

not work, simply copy and paste the path of your working directory into

the text field.

In Snaphu Export tab, select TOPO as Statistical-cost mode and select 200

pixels for Row Overlap and Column Overlap if you want to multilook.

Depending on the number of processors of your computer, you can also

increase the Number of Processors variable.

Select MCF.

Click Run to create the SNAPHU_Export file

The folder now holds files used for phase unwrapping: the coherence

image (*.img) and metadata (*.hdr), the wrapped phase: image (*.img)

and metadata (*.hdr), the unwrapped phase: only the metadata (*.hdr),

because the image (*.img) is first to be created by snaphu in the next

step, a configuration file (snaphu.conf) containing the parameters defined

in the export operator
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Unwrapping of the phase

You should see the wrapped interferogram phase “Phase_ifg*.img”,

coherence “coh_*.img”, and a “snaphu.conf” file.

For the next step, you will need to instal SNAPHU in Windows. SNAPHU is a

tool for phase unwrapping of interferometric information. To use it as an

executable file (*.exe) in Windows it has to be compiled first so all required

drivers (*.dll) are installed correctly. Follow the steps for installation here:

file:///C:/Users/Ona%C4%8Dillov%C3%A1/Downloads/Installation_SNAPH

U_English_ABraun.pdf

To start unwrapping, check the location of the interferogram exported from

SNAP. If snaphu.exe is not in your system’s PATH variable: Copy it in there

as well. It is recommended to store the data and snaphu on the same disk.

Open Command Window Here.

Type snaphu and hit Enter. The help menu should be displayed.

The command to start the unwrapping is shown in the file snaphu.conf.

Open it with a text editor. The beginning of the “snaphu.conf” file shows

the command to call Snaphu
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The Snaphu program can take a long time to run. At the end it writes

unwrapped phase to “Unw_ifg*.img” file

Import of the unwrapped phase

Now, we import the unwrapped phase. From the top main menu bar, select

Radar > Interferometric > Unwrapping, and then Snaphu Import that

converts it back into the BEAM DIMAP format and adds the required.

Read-Phase: should be set to the wrapped product that you

exported(before the export)

Read-Unwrapped-Phase: select the unwrapped phase product: Navigate to

folder where you exported for Snaphu. Select the

“UnwPhase_ifg*.snaphu.hdr” file. Note: The error message will then vanish

if you proceed to the next tab.

SnaphuImport: Leave the option “Do NOT save Wrapped interferogram in

the target product”

unchecked, because it is required in the later step.

Write: To store the imported unwrapped band in a separate product

(recommended), add ‘_unw’ to the end of the output name and click Run.

Finally, a new product is added to the Product Explorer which contains the

the unwrapped phase that we can display.
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Select the Unw_Phase_ifg band. Double click on this unwrapped phase to

see if the unwrapping was successful. It should be a smooth raster with

little variation except for the areas of expected deformation.

All fringe patterns are summarized to absolute changes. Go to the Colour

Manipulation tab and select “100%” to stretch color scale to full range of

unwrapped data. Unwrapped phase is still in radians. Phase is reference

image minus coregistered image. If reference image is earlier, then

negative phase is land moving toward satellite (negative range change)
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Create subset (optional)

In the earlier stages of processing, empty

pixels along the interferogram's perimeter

may have been created, particularly in

regions not overlapped by both input

images. To remove these sections, employ

the Subset function found under Raster.

This approach will also decrease processing

time in subsequent stages, especially when

the analysis is concentrated on a specific

area rather than the entire scene.



2.8 Phase to elevation

The unwrapped phase data is now a continuous raster, but it has not yet

been converted into a metric measure. To achieve this conversion from

radian units to absolute heights, the Phase to Elevation operator, found

under Radar > Interferometric > Products, is employed. This operator

translates the phase values into surface elevations along the line-of-sight

(LOS) in meters. The LOS represents the direct line between the sensor

and a specific pixel. To ensure accuracy, a Digital Elevation Model (DEM) is

utilized to align the elevation values correctly.

The I/O Parameters tab should be set to the last subset unwrapped

product

Default for target product name is to add “_dem” to the name

Navigate to the Processing Parameters tab and select SRTM 1Sec HGT

(AutoDownload) as the input DEM.

15



Now, we can display elevation result. Again, better to stretch colors.

Displacements is now in meters.

Sign was changed so positive displacement is “up” towards satellite

Profile plot
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2.9 Terrain Correction

SNAP calls geocoding with topography “Terrain Correction.” From the top

main menu bar, select Radar, then Geometric, then Terrain Correction, and

then Range-Doppler Terrain Correction.

The I/O Parameters tab should be set to the last elevation product

Default for target product name is to add “_TC” to the name

Under Processing Parameters tab, select the elevation band as the input

Select SRTM 1Sec HGT (AutoDownload) as input DEM.

If you want to export the data as a KMZ file to view it in Google Earth,

WGS84 must be selected as Map Projection (latitude and longitude).

If you want to compare the quality of the InSAR DEM, you can select DEM

as a further output.
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Now, double-click on the „elevation“ raster to display the geocoded

elevation raster output. Product is now evenly spaced in latitude and

longitude and shows the elevation for the study area. You can create

profile to see the elevation diversity.

2.10 Export .kmz to Google Earth

Geocoded products (projected to WGS84) can be exported as a KMZ file to

view in Google Earth (Pro):
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Select an appropriate

color scale and color

ramp from the Color

Manipulation tab.

Right click on the

elevation raster in the

View tab (or navigate

to File > Export >

Other > View As

Google Earth KMZ)

Choose a directory to

save the output .kmz

and provide a fitting

filename, then confirm

with Save.



Open the resulting KMZ file in Google Earth to observe the elevation

patterns overlaid on the satellite image base map.

Compare with LiDAR-derived DEM

Compare your Sentinel-1 derived DEM with Digital Elevation Model (DEM

5.0) with a resolution of 1 meter per pixel created from airborne laser

scanning data by ÚGKK SR. „Source of ALS data: ÚGKK SR“.

Open QGIS and comapre small LiDAR-derived DEM sample with our

resulted DEM derived using Sentinel-1 data. We can observe that there are

small differences in the elevation.
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Comparing Sentinel-1 derived DEMs and LiDAR derived DEMs, LiDAR

typically offers higher precision. This is because LiDAR directly measures

the distance between the sensor and the Earth's surface using laser pulses,

resulting in highly accurate elevation data. On the other hand, Sentinel-1

derived DEMs are generated using synthetic aperture radar (SAR) data,

which can be affected by factors such as vegetation cover and terrain

roughness, potentially leading to less precise elevation measurements

compared to LiDAR. Therefore, in terms of precision, LiDAR derived DEMs

are generally considered more accurate and reliable.

However, Sentinel-1 derived DEMs may be more cost-effective compared to

LiDAR due to the lower cost associated with satellite data acquisition and

processing. In this case, Sentinel-1 data are free of charge, available for

everyone after the registration. Also, for large-scale mapping, monitoring,

or areas with limited budget or accessibility, Sentinel-1 derived DEMs may

be preferable.

For more information, see the lecture: 12. Retrieval of digital elevation

model (DEM) from ESA EO data and comparison with LiDAR outputs
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EXERCISE 13 – TUTORIAL

Marine applicat ions: deriving nearshore bathymetric

model with Sentinel 2 data using SNAP software

UNIVERSITY COURSE EARTH OBSERVATION APPLICATIONS



In this exercise,we will:

 Learn the basic steps to derive near-shore bathymetry based on S2
images

 Preprocess the image to correct for atmospheric effects

 Identify and select appropriate bands for bathymetric analysis,

particularly focusing on near-infrared (NIR) and shortwave infrared
(SWIR) bands which penetrate water more effectively.

 Utilize empirical relationships to estimate water depth based on

reflectance values in selected bands.

 Visualize the derived bathymetry map to interpret and analyze
water depth variations across the coastal area.

1 | Exercise outline
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Deriving bathymetry using Sentinel-2 data

Deriving bathymetry, or the measurement of water depth, using Sentinel-

2 data involves leveraging the satellite's multispectral capabilities,

particularly in the near-infrared (NIR) and shortwave infrared (SWIR)

bands, to penetrate water and assess bottom reflectance. While Sentinel-2

imagery is primarily designed for land observation, it can still provide

valuable information for coastal and shallow water applications.

Our approach to derive bathymetry from Sentinel-2 data involves

exploiting the attenuation of light with depth in water. Water absorbs and

scatters light as it penetrates deeper, with longer wavelengths like NIR

and SWIR being less affected. By analyzing the reflectance values of these

bands in shallow coastal areas, researchers can estimate water depth

based on the relationship between reflectance and depth.

For bathymetric estimation in this exercise we use satellite imagery and

empirical models that establish relationships between satellite-derived

reflectance values and measured water depths from field surveys. By

calibrating the model with ground truth data, researchers can predict

water depth from reflectance values in Sentinel-2 bands.

Challenges in deriving bathymetry from Sentinel-2 data include

atmospheric effects, water surface roughness, and bottom substrate

variability. Additionally, accurate ground truth data for calibration and

validation are essential for ensuring the reliability of bathymetric

estimates.

Despite these challenges, Sentinel-2's frequent revisits and high spatial

resolution make it a valuable tool for coastal and shallow water

bathymetry mapping, aiding in coastal zone management, environmental

monitoring, and habitat mapping. Ongoing research continues to refine

and improve bathymetric estimation techniques using Sentinel-2 data.

2 | Background
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2.1 Study area and data used

For this exercise, we will use Sentinel-2B image of the area Is Arenas

Biancas, south of Cagliari, with its expanse of white sand, a vivid blue

seabed and dunes covered in greenery behind it, using the Tile Number

*32SMJ* downloaded for 26 August 2023 from the Dataspace Copernicus

Open Access Hub [@https://dataspace.copernicus.eu/].

2.2. SNAP – Sen2Coral

Open SNAP Desktop and check if the Sen2Coral Toolbox that we will need

for this exercise is installed. The Sen2Coral Toolbox is a SNAP extension

dedicated to the mapping (habitat, bathymetry, and water quality) and

detection change for coral reef health assessment and monitoring.

Navigate to Tools – Plugins and check whether the Sen2Coral Toolbox is

Installed in the Installed tab. If it doesn´t appear there, go to Available

plugins and install it. To complete the installation process, restart of the

application is needed. After that, you can check if it was installed

succesfully – Navigate to Optical – Thematic Water Processing –

Sen2Coral plugin should be there.
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2.3. SNAP - Open and explore product

Open SNAP Desktop, click Open Product and open downloaded Sentinel-2

product (unzipped) by double click on the metadata „MTD_MSIL2A.xml“

inside the folder. The opened products will appear in Product Explorer

window.

S2B_MSIL2A_20230826T100559_N0509_R022_T32SMJ_20230826T134424.SAFE

Display the product using e.g. True color composition:

Right click on the product – Open RGB Image Window – select Sentinel 2

MSI Natural Colors.

For this exercise, only bands with a spatial resolution of 10 meters will be

employed: the Visible Blue (B2), Green (B3), Red (B4), and Near Infrared

band (B8) due to their strong linear correlation with water depth. The

NIR band is utilized for land masking.

To view these four bands in the View Window, navigate to the Bands

folder of the image and double-click on them (B2, B3, B4, B8). Ensure

synchronization of views by going to the Navigation tab in the lower left

(red arrow) and confirming that the cursor and views are linked.
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2.4 Resample

The Sentinel-2 products consist of 13 bands with varying resolutions,

impacting their sizes. Since several operators in the SNAP toolbox cannot

handle products with bands of different sizes, it is necessary to initially

resample the bands to ensure uniform resolution.

Navigate to Raster→ Geometric → Resampling.

In the I/O Parameters tab, set the name for the "Target Product," as

S2B_20230826_resampled and set the Directory where the resampled

product will be saved.

In the Resampling Parameters tab, under "Define size of resampled

product," select: By reference band from source product: B2.

Click Run. After the process is completed, if a window appears, click OK.

Close the Resampling Window.

A new product [2], named S2B_20230826_resampled appeared in
the Product Explorer Window.

2.5 Subset

The initial phase of the methodology involves reducing the original size

and number of bands in the image. To accomplish this, choose the

Sentinel-2 resampled product in the Product Explorer, then proceed to

Raster -> Subset.
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In the Spatial Subset tab select the Pixel Coordinates tab, set the
following parameters:

Scene start X: 4000
Scene start Y: 6000

Scene end X: 8000
Scene end Y: 10000

In the Band Subset tab, choose only the bands that we will need: B2, B3,
B4, B5, B8 and click OK:

Right-click on the subset product that will appear at the Product Explorer
and click Open RGB image window and from the dropdown menu select
Profile: Sentinel 2 MSI Natural Colors (B4, B3, B2) and click OK. Now
we can see it contains only the area we selected to create subset.
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2.6 Sun Glint Correction

Sun glint is a common phenomenon in satellite images and it essentially

refers to the specular reflection of the sun on water surfaces. The water-
leaving reflectance can be difficult to observe due to the reflection of
direct sunlight on the air-water interface (sunglint) in the direction of the
satellite. The viewing geometry of Sentinel-2 satellite makes it vulnerable
to sunglint contamination. Sun glint removal is a pre-processing step of

multispectral images which is necessary when the amount of sun glint
prevents the visibility of the sea bottom, usually in cases of marine habitat
mapping.

There are several available sun glint removal methods for high resolution
images and coastal applications. In this exercise we will apply the deglint
methodology using SNAP plugin Sen2Coral.

To apply the correction we have to use one or more image samples of sun

glinted regions to scale the relationship between the NIR signal and sun
glint.

Right-click on the last subset product and click Open RGB image window
and from the dropdown menu select Profile: Sentinel 2 MSI Natural Colors
(B4, B3, B2) and click OK.

As you can see in the image, there are bright areas on the deep water –
sunglint

Now, we will create samples from those pixels as well as glint-free pixels.

Go to Vector – New Vector Data Container
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Set the parameters for new vector layer:

Name: Glint samples

And click OK.

The new vector data container layer „Glint_samples“ has been added in the
Vectors folder of our subset product in the Product Explorer Window.

Let´s create some glint samples. For that, you can use RGB composition as
well as one of the bands, e.g. band 8 (try to play with histogram to better

see the sunglint ares)aClick on the Rectangle drawing tool icon int he Menu
bar and draw the samples (at least 4) that includes sunglint and also glint-
free pixels.

After that, we will use Deglint processor tool. (Note: if the product involves
Tie-pont grids folder with some data, delete it first)
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Navigate to Optical – Thematic Water Processing – Sen2Coral – Processing
modules – Deglint processor

In the I/O Parameters tab, select the last subset product. In the Processing
Parameters set the following parameters:

Sun Glint Areas: Glint_samples

Source Bands: select B2, B3, B4, B5

Reference Bands: select B8

After that, new product with „deglint“ at the end is created in which land
areas are also masked automatically. You can open an RGB image if you
want before and after applying the sunglint correction and compare them.

2.7 Dark-Object Atmospheric Correction

Dark Object Subtraction (DOS) is a practical method for atmospheric
correction, assuming that dark objects reflect atmospheric scattering. By
subtracting the atmospheric offset, calculated as the histogram's cut-off
point at the lower end, from each pixel in a band, this method effectively
corrects for atmospheric interference. Optically-deep water, with an

anticipated zero reflectance, is considered the most suitable dark target for
this purpose (Chavez, 1998).
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Now, let´s mask the clouds.

Navigate to Optical – Thematic Water Processing – Sen2Coral – Processing

modules – LandCloudWhiteCapMaskOpt

Now, we have create the new product. If we open the folder Bands for this
new product in the Product Explorer, we will see that new layer was
created. Double click to see it.
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Now, open the RGB composition for the last product and RGB composition
of the original resmapled product without any correction. Tile Windows
Horizontally and set the histogram for RGB of the last product similar to
the histogram of the original resampled product without any correction.

We can see that residuals (clouds, sunglint) have been corrected correctly.

However, if we visualise e.g. B2, we can see that there are still some couds
that need to be removed. We will create the final mask which will contain
all the invalid features.

Right click on the product – Band Maths:

Name: mask_all

Deselect Virtual and click on Edit Expression
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The final mask will appear in the new Window.

2.8 Empirical Bathymetry

Navigate to Optical – Thematic Water Processing – Sen2Coral – Processing
modules – EmpiricalBathymetry processor

In the I/O Parameters tab select the resampled and sun-glinted mask

In the Processing Parameters choose bands B2 and B3 to estimate the
bathymetry that give us the best trade-off between the water penetration

depth and the spatial resolution

Then, choose the .csv file containing the set of bathymetry point data
(latitude, logitude, depth) – these data have been derived using Coastal

Relief Model Mosaic from https://www.ncei.noaa.gov/maps/grid-extract/

N value: 10000.0 (default)
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Now, we will mask the bathymetric product with the final mask

Right click on the bathymetric product – go to Band Math

Unselect virtual raster

Go to Edit Expression and type in the following expression like in the image

21
7
14



In the Product Explorer Window, the new product is created. Double click
on its band to visualize it.

Go to the Colour Manipulation tab and select the colour palette. Set the
range according the data. Explore the values of the final output on
bathymetry in this area

For more information, see the lecture: 13. Marine applications: nearshore
bathymetry, sea surface monitoring
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